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About this guide

The Vicon Tracker User Guide provides product information, user assistance, and
operational expertise to help you capture and analyze motion data. It will help you
confirm your basic understanding of any steps; investigate a process, step, or option in
more detail; try more advanced features; or pick up best practice tips.
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About Vicon Tracker documentation

The following documentation is available for the current Tracker release:

Document Description

What's Describes the latest release of Tracker, including details of how to use
New in the new features.

Vicon PDF available from Vicon website and as online help.

Tracker

Vicon Explains how to install, license, and use Tracker with Vicon camera
Tracker systems (including Vicon Vero, Vicon Vantage, Bonita Optical, and T-

User Guide  Series cameras and units)
PDF installed with Tracker and available as online help.

The User Guide PDF is installed as part of your Tracker software installation.

You can also obtain the Tracker PDFs, and other Vicon documents, from http://docs.
vicon.com/ and from the Downloads page of the Vicon website.

(@ Note

The documents available to you depend upon your Vicon software license
options.

Vicon Motion Systems Ltd. 02-Nov-2016 Page 5 of 173


http://docs.vicon.com/
http://docs.vicon.com/
http://www.vicon.com/downloads

Tracker

“ICON User Guide

Installing and licensing Vicon Tracker

Vicon Tracker is a powerful object-tracking solution, providing unrivaled data accuracy
for integration into 3D applications. It enables you to use Vicon camera hardware for
tracking rigid bodies, accurately streaming 6 Degrees of Freedom data in real time with
very low latency.

Forinformation on Tracker, its requirements, installation and licensing procedure, see
the following topics:

I Vicon Tracker requirements on page 7
I Install Vicon Tracker on page 8
I License Vicon Tracker on page 9

Some of the Tracker controls described in this document are available only if you have
licensed the relevant options. For information on licensing options, contact Vicon
Support (see Contact Vicon on page 173).
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Vicon Tracker requirements

Tracker 3.4 is compatible with and fully supported under 64-bit installations of
Windows 7. Installation and software operation are tested under this operating system.
Tracker works with data from Vicon systems (including Vicon Vero cameras, Vicon
Vantage cameras and units, Vicon Bonita cameras, and Vicon MX T-Series cameras and
units). It is also compatible with the Vicon Virtual System, enabling you to integrate it
into your software without having to use a camera system.

License servers

If your organization licenses its Vicon product(s) from a server, ensure that the server
meets the following criteria:

I Itis unlikely to be powered down.
I It has a static IP address, so client machines can find it easily and reliably.

I Itis unlikely to have its hardware configuration changed, especially the HDD and
NICs.

If your organization already uses a server, it is likely to fulfill the above criteria.
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Install Vicon Tracker

Tracker 3.4 automatically installs into its own folder, so your old Tracker installation is
unaffected. Any old files that you choose to import into Tracker are copied from their
original locations, leaving the originals untouched.

The procedure for installing Tracker is the same as that for other Vicon products.

To install Tracker:

1. Download and extract the appropriate installation file from the Vicon website.

2. Double-click the installation file.

(D Note

If you are upgrading from an earlier version of Tracker, note that before
proceeding with installation, Tracker 3 automatically scans for Tracker 2.
x files, displays a list of any older files that it finds, and provides an
automated system for importing these into Tracker 3. This process
copies all the old files and converts the copies, ensuring that original
files are not moved, altered, or destroyed.

3. Follow the instructions on each wizard page, completing the required details.
The Tracker installer enables optional installation of the License Server software
for server-based licensing, and the dongle drivers for licenses that are locked to
dongles. The License Server software is installed by default, but the dongle
drivers are not. For information on the licensing utility (VAULT), see License
Vicon Tracker on page 9.

4. If you are prompted to restart your PC, do so as soon 3s possible.
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License Vicon Tracker

From version 2.2, Vicon Tracker uses Safenet licensing and a built-in licensing utility:
the Vicon Automated Unified Licensing Tool (VAULT).

You specify the license server via a dialog box that appears if no license is found or via
the Help > Vicon Product Licensing menu option. The server name is stored in the
following file under Windows 7:

<InstallationDrive>:\Users\Public\Documents\Vicon\Licensing\TrackerLiclnfo.xml|

If you need to view or manage licensing while you are using Tracker, on the Help menu,
click Vicon Product Licensing. To find out which features are licensed, click About
Vicon Tracker and then click Feature Details.

To start using Tracker, you must first request a license and activate it. You may also
need to set the license server for your license. If you want to use Tracker remotely, you
will need to set up commuter licensing. For details of these procedures, including
information about commuter licensing, see the following topics:

I Request alicense on page 10

I Activate a license on page 11

I Set the license server on page 12

I View information about license servers on page 14

I Move and revoke Vicon Tracker licenses on page 15
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Request a license

To request a license, you start Vicon Tracker and supply the relevant details.

To request a license from Vicon Support:

1. If you are using a SafeNet dongle to license your machine:

a. Ensure you've installed the latest dongle drivers on the PC on which you
will run Tracker. You can either choose the option for dongle drivers when
you install Tracker, or run the Vicon Tracker installer at any time, or you
can download the drivers from the Vicon website.

b. Insert the dongle.

2. On the machine for which you want the license (either a networked license
server or a standalone machine), start Tracker and at the left of the dialog box,
click Request License.

@ Tip
You can also manage licensing in the following ways:

— After you have licensed Tracker, start Tracker and on the Help menu,
click Vicon Product Licensing; or

—To run the Vicon Automated Unified Licensing Tool (VAULT)
independently of Tracker, click the Start button, then All Programs >
Vicon > Licensing > Vicon Product Licensing.

3. At the top of the Request a License dialog box, from the Product and Product
Version menus, ensure Vicon Tracker and 3.2 are selected.

4. In the appropriate fields, type your name, email address and company name.
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5. In the Options area, select whether to request:

I Standalone license locked to local PC name: for use by the PC from which you
are sending this request only

I Network license locked to license server name: for use on the license server
machine from which you are sending this request by one or more PCs on the
same network

I Standalone license locked to a dongle: for use with the specified dongle on a
single PC. In the Dongle ID field, type the ID (found on the dongle).

I Network license locked to a dongle: for use on a license server machine by one
or more PCs via the specified dongle. In the Dongle ID field, type the ID, which
is found on the dongle.

6. For network/server based licenses only: if necessary, change the value for the
Number of Seats.

7. Leave the settings in the Machine area at their default values unless you are
asked to change them by Vicon Support (for example, if you are using a dual-
booting system or have had to reinstall Windows).

8. Do one of the following:
I If you can email your license request, click the Email Request button; or

I If email is currently unavailable, click Save Request to a file, so that you can
send the request later. Type or browse to a suitable location and click OK. The
file is saved as ViconlLicenseRequest*.xml. When possible, email the file to
Vicon Support.

Activate a license

After you have received a license file from Vicon Support, you must activate it before
you can start using Vicon Tracker.

To activate a license:

1. Check your email for a message from Vicon Support. The license file (named
Vicon Tracker Release Number License Type.lic, eg, Vicon Tracker 3.2 Network.lic
) is attached to the email. If you're using a Safenet dongle, the Subject line of the
email has the ID of your dongle (of the form UBnnnnnn)
If you have not received a license file, request one as described in Request a
license on page 10.

2. Save the license file (*.lic) to the Windows desktop of the machine for which you
have a license (or any other suitable location).
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3. Start Vicon Tracker and in the Vicon Automated Unified Licensing Tool dialog
box, click Activate License.

4. Depending on whether you are using the file as it was received from Vicon
Support or as a text string copied from the file:

I In the License File Activation field, type or browse to the location of the
license file (*.lic) and click Activate from File; or

I Copy the text to the License Activation string field and click Activate from
String.

5. Click OK.

®@ Tip

You can deactivate a network license from the relevant license server machine
only, not from any of the client machines.

When you have activated your license, you are ready to start using Vicon Tracker.,

Set the license server

If 3 server provides licenses to client PCs on your network, to enable a client PC to find
its license quickly, on the client PC specify the license server for Vicon Tracker to use.

If you use standalone licensing, Vicon Tracker should find its license. If not, or if you
need to change the license server, complete the following steps.

To enable Vicon Tracker to find its license:
1. Ensure you have installed Vicon Tracker as described in Install Vicon Tracker on

page 8. Depending on the type of license you have, ensure that your system is
ready:

I If your PC obtains its license from a license server, ensure that Vicon Tracker is
licensed on the relevant server.

I If you are using a standalone license, ensure that you have requested, saved
and activated your license on this machine.
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2. Start Vicon Tracker and depending on whether or not a license is found:

I If the Vicon Automated Unified Licensing Tool dialog box opens, click Set
License Server; or

I If Vicon Tracker opens and you want to view or change the current license
server:

a. On the Help menu, click Vicon Product Licensing.

b. In the Vicon Automated Unified Licensing Tool dialog box, go to the
Product License Location list (in the lower half of the dialog box), and
right-click on the line that shows the relevant Vicon Tracker license and
then click Set License Type.

I In the Change License Server dialog box, do one of the following:

I To use standalone licensing, select Use Standalone/Commuter Licenses Only and
then click OK,

I To obtain a license from any available license server (local or on a network), select
Use Standalone/Commuter Licenses Or Scan for a License Server and then click
OK.

I To select a specific license server from a list of available servers:
I Click Discover. Local and network licenses are displayed.

I In the Available Servers list, double-click the required license server and then
click OK.

I To specify a license server on your network, select Use a Specific Network License
Server, type the name in the License Server field, and click OK,

®@ Tip

You can instead select the required license server by going to the License
Server list (in the upper half of the Vicon Automated Unified Licensing Tool
dialog box), right-clicking on the line that shows the relevant Vicon Tracker
license and then clicking Use This License for Vicon Tracker.
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View information about license servers

In the Vicon Automated Unified Licensing Tool dialog box, you can view information
about all available license servers without affecting the license server that is currently
in use. To do this:

1. Open the advanced Vicon Automated Unified Licensing Tool dialog box by doing
one of the following:

I Before licensing Vicon Tracker, start Tracker and in the Vicon Automated
Unified Licensing Tool dialog box, click Advanced Licensing; or

I After Tracker is licensed, start Tracker and on the Help menu, click Vicon
Product Licensing to open the Vicon Automated Unified Licensing Tool dialog
box; or

I Click the Windows Start button, then All Programs > Vicon > Licensing > Vicon
Product Licensing.

2. In the Vicon Automated Unified Licensing Tool dialog box, if the required license
server is not displayed in the License Server field at the top, click Change at the
top right of the dialog box.

3. In the Options area of the Select License Server dialog box, do one of the
following:

I To view local standalone licenses and commuter licenses (see Use commuter
licenses on page 15), select View Licenses from the Locally Installed License
Server; or

I To view licenses on a specified license server, type the name of the required
server in the License Server field. If you don't know the name of the license
server, click Discover and in the Available Servers list, double-click a license
server.

4. Click OK.
In the License Server list, the top part of the Vicon Automated Unified Licensing
Tool dialog box displays licenses from the specified license server.

®@ Tip

Changing the license server that is displayed in the License Server list does
not affect the license server that is used for licensing, shown in the Product
License Location list in the lower part of the dialog box. To change the license
server that is used for licensing, see Set the license server on page 12.
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Move and revoke Vicon Tracker licenses

While using Tracker, you may find that you want to temporarily use a seat from a
license on @ machine that is not on the license server network (commuter licensing), or
that you need to permanently move the license from one machine to another, involving
license revocation.

The following topics contain information on how to:
I Use commuter licenses on page 15
I Check out to a network machine on page 16
I Check out to a remote machine on page 16
I Generate a locking code on the remote machine on page 17
I Check out a commuter license on a network machine on page 17
I Save and activate the commuter license on the remote machine on page 18
I Checkin a commuter license on page 19

I Revoke a license on page 20

Use commuter licenses

After you have licensed Vicon Tracker, if required, you can check out (borrow) a seat
from a network license so that it can be used for the number of days that you specify,
on a machine that is not connected to the license server network (known as commuter
licensing). You can check out a seat to either:

I A machine on your network (see Check out to a network machine on page 16), so
that Tracker can subsequently be used when the machine is no longer connected to
your network; or

I A machine that is not connected to your network (see Check out to a remote machine
on page 16)

When a commuter license is no longer needed, it is checked back in again, so that it
can be used from the license server network as usual. Licenses are automatically
checked in at the end of a specified check-out period, or can be manually checked in
early (not applicable to remotely checked-out licenses), For more information, see
Check in a commuter license on page 19.
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Check out to a network machine

You can check out a seat from an existing license for use on @ machine on your license
server network, so that Tracker can subsequently be used on the machine when it is no
longer connected to your network.

To check out a seat to a machine on the license server network:
1. On a network machine that you later want to use remotely, open the advanced
Vicon Automated Unified Licensing Tool dialog box by:
I Starting Tracker and on the Help menu, clicking Vicon Product Licensing; or

I Clicking the Start button, then All Programs > Vicon > Licensing > Product
Licensing.

2. In the License Server list in the top part of the dialog box, right-click on the
license that contains the seat that you want to check out and click Check Out.

3. In the Check Out License dialog box, specify the number of days for the license

to be used remotely and then click Check Out.

Checked out licenses are flagged with Commuter in the Type column in the License
Server list in the top part of the Vicon Automated Unified Licensing Tool dialog box.

Check out to a remote machine

In addition to checking out a license to a network machine (see Check out to a network
machine on page 16 above), you can also check out a license to a machine that is
running the Vicon Automated Unified Licensing Tool (VAULT), but is not connected to
the network containing the license server. This involves the following procedures:

I Generate a locking code on the remote machine on page 17 and send it to a user of
a machine on the license server network.

I Check out 3 commuter license on a network machine on page 17 and send it to the
remote user.

I Save and activate the commuter license on the remote machine on page 18
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Generate a locking code on the remote machine

On the remote machine on which you want to use Vicon Tracker, use VAULT to
generate a locking code, which can then be sent to someone on the network that
includes the Tracker license server.

To generate a locking code:
1. To open the advanced Vicon Automated Unified Licensing Tool dialog box, do
one of the following:

I Start Tracker and in the Vicon Automated Unified Licensing Tool dialog box
click Advanced Licensing; or

I Click the Start button, then All Programs > Vicon > Licensing > Product
Licensing.

2. In the Vicon Automated Unified Licensing Tool dialog box, click View Remote
Locking Code.

3. In the Current Machine Locking Code dialog box, type the email address of a
person to whom the network license server is available, and click Send, or to save
it to a string to send later, type or browse to the required location and filename,
click Save to File and close the dialog box.

The person with access to the license server can then check out a commuter license
for use on the remote machine, as described in Check out a commuter license on a
network machine on page 17.

Check out a commuter license on a network machine

When you receive a locking code for a remote machine, you can use the locking code to
enable you to check out a license for the number of days that you specify. You can
then send the license to the user of the remote machine.

To check out a commuter license:
1. To open the advanced Vicon Automated Unified Licensing Tool dialog box, do
one of the following:
I Start Vicon Tracker and on the Help menu, click Vicon Product Licensing; or

I Click the Start button, then All Programs > Vicon > Licensing > Vicon Product
Licensing.

Vicon Motion Systems Ltd. 02-Nov-2016 Page 17 of 173



Tracker

User Guide

2. In the License Server list in the top part of the dialog box, right-click on a license
that permits commuter licensing for Tracker.
If the selected license permits commuter licensing, the context menu displays a
Check Out option and at the bottom of the dialog box, a Check Out button is
displayed.

3. Click Check Out and in the Check Out License dialog box:
a. Specify the number of days to use the license remotely.

b. Expand the Advanced Options by clicking the downward pointing arrow on
the right, and click Remote Check Out.

(M Caution

Do not overestimate the number of days for which the license will
remain checked out. After a remote check out, you cannot check the
license back in again until the number of days that you specified has
expired.

4. In the Remote Commuter License Check Out dialog box, enter the locking code
string for the remote machine that was emailed or sent by the user of the remote
machine, as described in Generate a locking code on the remote machine on
page 17 above, and click Check Out.

5. In the Save Commuter License dialog box, type or browse to a path and filename
for the saved commuter license, click Save to File and then close the dialog box.
The commuter license is saved as a license file (*.lic).

6. Email the saved commuter license file to the remote user.

The remote user can then save and activate the checked-out commuter license
on the remote machine, as described in Save and activate the commuter license
on the remote machine on page 18.

Save and activate the commuter license on the remote machine

When you receive a license file for a remote machine, you can use VAULT to activate
the license for use on the remote machine.

1. Save the file that was sent to you as described in Check out a commuter license
on a network machine on page 16 above to the Windows desktop (or any other
suitable location).

2. To open the advanced Vicon Automated Unified Licensing Tool dialog box, do
one of the following:
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I Start Tracker and in the Vicon Automated Unified Licensing Tool dialog box
click Activate License; or

I Click the Start button, then All Programs > Vicon > Licensing > Product
Licensing, and then click Activate License.

3. Depending on whether you are using the file as it was received from the license
network user or a text string copied from the file, do one of the following:

I In the License File Activation field, type or browse to the location of the
license file (*.lic) and click Activate from File; or

I Copy the text to the License Activation string field and click Activate from
String.

4. Close the Activate a License dialog box.
In the License Server list in the top part of the Vicon Automated Unified
Licensing Tool dialog box, checked out licenses are flagged with Commuter in
the Type column.

Check in a3 commuter license

Licenses that have been checked out are checked back in and made available for use
from the network in either of the following ways:

I If the specified check-out period has expired, the license is automatically checked
backin.

I If the license is no longer needed for remote use, you can check it back in early.

(D Caution

This does not apply to licenses that were checked out using Remote Check
Out, which remain checked out until their check-out period expires.

To check in a license manually:

1. To open the advanced Vicon Automated Unified Licensing Tool dialog box, do
one of the following:

I Start Tracker and on the Help menu, click Vicon Product Licensing; or

I Click the Start button, then All Programs > Vicon > Licensing > Product
Licensing.
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2. In the top part of the Vicon Automated Unified Licensing Tool dialog box, click
on the license you want to check in and then click Check In License.

You cannot check in a license that was checked out using Remote Check Out
before its check-out period has expired. You set the check-out period when
you check out a license. To see how many days are left on a commuter license,
in the License Server list in the top part of the Vicon Automated Unified
Licensing Tool dialog box, find the relevant license and look at the date in the
Expiry column.

Revoke a license

You may find that you need to move your Vicon Tracker license to a license server
machine that is different from the one for which you originally obtained the license. To
do this, you must revoke the original license. (If you want to temporarily use a single
license seat on a remote machine, see Use commuter licenses on page 15.)

To avoid delays when changing license servers, before clicking Revoke License
in the Vicon Automated Unified Licensing Tool dialog box, email Vicon
Support and wait to receive a reply.

Ensure that your email to Vicon Support includes the following details:

I The Vicon product name (ie Vicon Tracker) and license revocation in the
Subject line of the email.

I Information about the license that you want to revoke, including number of
seats and locking code of the license server machine.

I The locking code of the machine to which you want to move the license.
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Introducing Vicon Tracker

Vicon Tracker is a powerful object-tracking solution, providing unrivaled data accuracy
for integration into 3D applications. It enables you to use Vicon camera hardware for
tracking rigid bodies, accurately streaming 6 Degrees of Freedom data in real time with
very low latency.

To get started with Vicon Tracker, you set up your Vicon system and then prepare the
objects for motion tracking.

The user interface guides you through the various tasks. When you are familiar with the
basics, you can customize Tracker to look and behave as you want.

For more information, see the following topics:

I Prepare the capture environment on page 23

I Tracker system components on page 25

I Connecting cameras on page 30

I Setting up a mixed Vicon camera system on page 31
I Vicon file types used in Tracker on page 33

I Setting properties in Tracker on page 34

I About the Tracker user interface on page 37

I Customizing the Tracker user interface on page 39

I Mouse and keyboard shortcuts on page 41
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Finding information about Tracker

You can find information about your Tracker installation by using the relevant options
on the Help menu.

Check your licensed Tracker options

To check your currently licensed Tracker options:

1. From the Help menu, click About Vicon Tracker.
2. In the window, click the Feature Details button.

3. After a few seconds, the currently licensed options are listed in the Licensed

features dialog box.

4. When you have checked the options available, click Close.

Find Tracker version information

To check the version number of Tracker, from the menu bar, select Help > About Vicon
Tracker.

The version number is displayed in the bottom left of the window that is displayed. This
information may be requested if you contact Vicon Support with questions about Vicon

Tracker.
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Prepare the capture environment

Before you begin connecting up and using your Vicon system, to ensure its precision
and accuracy:

I Choose an optimal measurement volume for a given experiment
I Place cameras to achieve uniform precision in all directions
I Consider the mechanical stability of the cameras and their mountings.

As the resolution of Vicon cameras has increased, mechanical stability has become
increasingly important, because a very small shift in position can have an impact on
system measurements, as shown in the following example.

Example of the effect of changes in camera position on
system precision

A Vicon T160 camera with a standard 18 mm lens has a horizontal field-of-view of 54°.
Each pixel subtends an angle of 0.0115° or 200 micro-radians.

In other words, a change of 200 micro-radians in the angular position of the camera
and its sensor represents a one pixel shift in the system's measurements. This shift is
equivalent to about a quarter of the diameter of a 12mm marker at a range of 16m.

(@ Note

This is a 2D shift. All 3D measurements are estimated from the intersection of
several 2D rays, so the resulting 3D shift may be smaller.

Maximizing data quality

The most common causes of imprecision of 3D data are;

Mounting creep

Scenario: Cameras are often clamped onto a framework that allows their position and
orientation to be easily adjusted. The framework is commonly cylindrical tube and the
clamps depend on friction.
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Problem: If 3 camera is cantilevered so that its weight may rotate the clamp, the
amount of slippage or creep at the clamp/frame junction needed to introduce 200
micro-radians of angular change is tiny: about 5 microns or about 1/50th of the
diameter of 3 human hair. This slippage is far too small to be seen.

Solution: To minimize the risk of movement, mount cameras so that their weight does
not rotate their mounting point either by bending the mounting frame or by causing a
clamp to slip or creep.

Vibration

Scenario: Many buildings are of steel-frame construction. A steel framework can
transmit vibrations caused passing footsteps, elevators, and passing vehicles. Most
building vibrations are locally translational and, while undesirable, have little direct
effect on camera rotation.

Problem: If 3 camera is mounted on a bracket or cantilever, building vibration combined
with the cantilevered mass of the camera can cause a rotational oscillation of the
camera mount.

Solution: Ensure that camera mounting brackets, and the structure to which they are
attached, are extremely stiff and cannot wobble if there is any vibration in the building
frame. This applies whether the camera mounting is vertical or horizontal.

Temperature

Scenario: Thermal expansion and contraction in large structures such as a building can
be very large but the temperature changes that drive them tend to be relatively slow
compared with the duration of a Vicon calibration/trial cycle.

Problem: One part of the system that changes temperature much more quickly is the
camera itself. The inside of a Vicon camera reaches a steady temperature of around 50°
Celsius. While the camera is warming up from the ambient temperature of its
surroundings, its internal components inevitably change dimension. However, when the
components reach operating temperature, their dimensions re main stable.

Vicon measures the effects of warm-up and ambient temperature changes on all its
cameras. All current camera models reach their steady operating temperature in
approximately 30 minutes. This time is relatively independent of ambient temperature
over the normal operating range of 0°-30°C. During warm-up, the equivalent positional
change varies between 0.25 pixel for lower resolution cameras to approximately 1 pixel
for the T160.

Solution: Allow Vicon cameras to warm up for at least 30 minutes before calibration
and measurement.
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Tracker system components

Tracker is part of the fully integrated and expandable Vicon system that lets you build
an architecture best suited to your motion capture application.
In the following architecture diagrams, Tracker is installed on the host PC.

Vicon Vantage system architecture
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T-Series system architecture
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About Tracker system components

You can include the following components in a Vicon Tracker system architecture:

Component

Vicon Vero
cameras

Vicon
Vantage
cameras

Bonita
cameras

MX cameras

Vicon Motion Systems Ltd.

Description

Vicon Vero cameras (v1.3 and v2.2) can be used with Tracker.

You can use Vicon Vero cameras in existing systems consisting of
Bonita cameras, Vantage cameras, and/or MX T-Series cameras, but
note that they cannot be connected to a Giganet.

Vantage cameras (V16, V8, and VV5) can be used with Tracker.

You can integrate existing systems consisting of Bonita cameras and
/or MX T-Series cameras into a Vantage system.

For more information, see What's New in Vicon Tracker, Vicon
Vantage Quick Start Guide and the Vicon Vantage Reference.

Bonita Optical cameras can be used with Tracker.

From Tracker 2.2 and above, your Tracker system can include both
Vicon Bonita Optical cameras (B3, B10) and MX T-Series cameras
(T10, 720, T40, T160).

For additional information, see Connecting cameras on page 30
and Setting up a8 mixed Vicon camera system on page 31.

Caution: The use of mixed systems that include Vicon cameras older
than T-Series and Bonita is not supported and is at your own risk.

The following MX cameras can be used with Tracker:

I MX T-Series cameras: T160, T40-S, T20-S, T10-S, T10

I MX F-Series cameras: MX-F40 (F40) and MX-F20 (F20)

I MX+ cameras: MX3+

For additional information, see Connecting cameras on page 30,

Important: Where the Tracker documentation refers to MX cameras,
unless otherwise noted, these references also apply to T-Series, F-
Series, and MX+ cameras.
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Component Description

Vicon Smart boxes that can be combined to create a distributed
Connectivity  architecture, enabling you to customize the number of Vicon
units cameras:

I Vicon Lock+: Facilitates the integration of synchronous third-party
equipment with Vicon Vantage and Vicon Bonita cameras by
providing or receiving synchronization and/or timecode. Also
provides connectivity for third-party analog capture sources, such
as force plates and EMG equipment. Connects to a PoE switch to
which Vicon cameras and the host PC are connected.

I MX Giganet: Link between Vicon cameras (Bonita and T-Series)
and the host PC, with a 5-port Ethernet switch for connection to
the host PC, and other client PCs. Can be integrated into a
Vantage system.

Vicon Lock+ and the T-Series hardware units are RoHS-compliant.

For more information, see About Vicon connectivity units on page
78.

Host PC The main PC in the Vicon system, with at least one dedicated
Ethernet port to enable Vicon system communications (in addition to
any other network ports on the PC). Vicon Tracker application
software is installed on this PC. Remote PCs may be used for other
Vicon application software or third-party applications connected to
the host PC via Ethernet.

Vicon Proprietary Vicon cables plus commercially available Ethernet cables

cables connect Vicon system components, providing a combination of
power, Ethernet communication, synchronization signals, video
signals, and data.

Vicon Apex Hand-held tracking device that enables you to interact with virtual
objects in a 3D environment. For more information, see About Vicon
Apex devices on page 93.

Vicon Specialized device used to accurately calibrate the Vicon system.
calibration
device
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Component Description

Vicon Supplies for the Vicon system, including markers, tape, and Velcro.
accessories

Vicon Vicon Tracker software, DataStream SDK and Vicon Virtual System.
engineering

software

Additional Depending on your licensing options, your Vicon system may also
analog include one or more additional devices, such as LVDTs,

devices accelerometers, and load cells.

For more information, see Set up analog devices on page 87.

For further details on these components, see the Vicon Vantage Reference PDF, Go
Further with Vicon MX T-Series reference book and/or the Vicon Bonita Quick Start
Guide, which can be downloaded from the Vicon website.
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Connecting cameras

To connect cameras into your Vicon system, you must specify the correct IP address for
the network card that is connected to the PoE switch or Giganet.

To connect the cameras:

1.
2.

© © N o o &

Connect the PoE switch or Giganet to the PC.
Access the Windows network connections:

I Open the Control Panel, then click Network and Internet and on the right side
of the panel, under Network and Sharing Center, click View Network Status
and Tasks; or

I Click the Network and Sharing Center icon on the right of the Windows toolbar
and then click Open Network and Sharing Center.

Right-click on the network card connected to PoE or Giganet and then click
Properties.

In the Properties window, select TCP/IP.

Click the Properties button.

In the Properties window, click the Use the Following IP Address radio button.
Enter the following IP address: — 192.168.10.1.

Enter the following Subnet Mask — 255.255.254.0.

Click OK.
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Setting up @ mixed Vicon camera system

Tracker enables you to capture with mixed Vicon camera systems consisting of Vicon
Vero cameras (v1.3 and v2.2), Vicon Vantage cameras (V5, V8, V16) and/or Vicon MX T-
Series cameras (T10, T20, T40, T160, or S Edition), and Bonita Optical cameras (B3,
B10).

For systems involving only Vero, Vantage and Bonita cameras, the shutter period
characteristics for all cameras match exactly. Irrespective of individual cameras’ strobe
(shutter) settings, the center alignment of these periods in any Vantage/Vero/Bonita
camera in the same system align exactly. You do not need to make any adjustments to
ensure that this alignment occurs.

However, for systems that include Vicon MX T-Series cameras, depending on your
requirements (see When are differences in strobe timings important? on page 32),
you may need to make some manual adjustment.

For more information, see:
I Understanding strobe timings on page 31

I Effect of differences in strobe timings in mixed MX T-Series camera systems on page
32

I When are differences in strobe timings important? on page 32

Support for mixed systems' center strobe alignment requires Vicon firmware
700 or later. (Vicon recommends that you always update the latest firmware.)

Understanding strobe timings

To obtain optimum performance from a mixed camera system that includes Vicon MX T-
Series cameras, it is important to remember that there is a difference in strobe duration
between the larger T-Series cameras and other current Vicon cameras.

For all current Vicon optical motion capture cameras, the strobe 'on' period and sensor
exposure period (the length of time that the sensor gathers data) are coincident.
Strobe intensity actually controls strobe duration and results in variable strobe and
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Sensor exposure periods across the cameras in the system. This therefore produces
small changes in timing between cameras. If your system includes MX T-Series
cameras, these differences can result in slight discrepancies in the times of the middle
of the pulses.

Effect of differences in strobe timings in mixed MX T-Series
camera systems

When you are setting up a mixed camera system that includes MX T-Series cameras,
you may need to consider the effect of strobe timings. A single reconstruction is the
result of two or more camera sensors recognizing the same marker. If two cameras with
significantly different strobe timings are used to track an object or marker, small
differences in the absolute timing of this data can occur. Depending on the speed and
type of motion being captured, these differences may or may not be a setup
consideration.

To obtain consistent strobe timing and sensor exposure:

1. In the System tree, select the MX T-Series camera(s).

2. Inthe selected camera's Properties pane, in the Settings section, ensure the
Strobe Intensity is set to its maximum setting.

This ensures that the center of the strobe pulse and shutter period for the Vicon Vero
/Vue/Bonita cameras matches that of the Vicon MX T-Series cameras.

When are differences in strobe timings important?

In situations where very small timing differences are considered to be relevant and
greater than other accepted limitations, set the Strobe Intensity for the MX T-Series
cameras to its maximum value, as described above. Situations that may warrant this
treatment include studies where very fast ballistic movements are expected and/or
where very small markers are likely to be in close proximity.
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Vicon file types used in Tracker

During the motion capture workflow, you create and edit a number of configuration
files, Vicon Tracker generates a number of data files, and you can import files from and
export files to other Vicon applications or supported third-party software.

You create and edit the following Vicon configuration file types during motion capture

and analysis:
File type Saved using Description
configuration
controls in
.options Options Data view options
dialog box
.system Resources System settings
pane, System
tab
ViewType View pane View options and layouts
sk Resources Vicon skeleton file
pane, Objects
tab
XCPp Resources Calibration parameters file. You can create, reset, and
pane, load an .xcp file but the .xcp file cannot be edited. You

Calibrate tab can export an .xcp created in Tracker to other Vicon
application software and supported third-party
software.
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Setting properties in Tracker

You can configure the way certain areas of Tracker look and behave by configuring
settings in the Properties pane. The properties you can configure depend on what is
selected in the Resources pane or the Options dialog box.

Some properties settings are automatically saved, so Tracker remembers them in
subsequent sessions. You must explicitly save other settings using the configuration
management controls for the relevant area of the Tracker window.

To configure Properties settings:
1. In the Tracker window, click on the relevant tab or open the dialog box
containing the properties you want to configure:

I For system components, in the Resources pane, click the System tab.

;4

. COMMECTED GO OFFLINE

& cauerate @ osects | O reco

UMNTITLED *

Carmeras

I For motion capture objects, in the Resources pane, click the Objects tab.
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2. In the Properties pane, click the Show Advanced link to view all of the available
properties.
PROPERTIES

PROPERTIES

4. In the Properties pane, view or change the setting for the required property
using its entry field or control:

I Select or clear a check box to switch the property on or off.

I Click the current color in the entry field to display the Select color dialog box.
In the Basic colors area, click the square for the required color, orin the
Custom colors area, define a new color.

I Click the drop-down arrow and select an entry from the list.

I Move the slider to the left to decrease the value or to the right to increase the
value displayed in the entry field.

I Overtype the existing value.

5. If you are working in the following areas of the Tracker window, save your
settings to the appropriate configuration file using the configuration
management controls:

I System tab

& CALIBRATE | 4 CB

I View pane

(=& ]

I Options dialog box

[ opTioNs

IUN'ITI'LED‘ VIEI'
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About the Tracker user interface

The Tracker user interface is laid out so you can locate buttons, menus, and controls
where you expect to find them.

Component Description

Resources pane  Manage the different components of your Vicon system
architecture and the objects whose motion is to be captured.

[ 4

i 5
. COMMECTED GO OFFLINE

2~ cauBrate @ oBiEcTs | ) RECORDING

UNTITLED *

View pane Set up the way you want to visualize the capture data from one
or more cameras.
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Component Description

Communications View log information.

pane
(DEVICE) Attempt 1 to open telnet connection to device 16969 succe
) Attempt 1 t n telnet connectio e cceeded
ce connected
iith priority of 100
MKSHAL ) Highest priority ethernet sync master 4294967295 with priority of 0
Menu bar Exit Tracker, undo/redo, open close panels, view help, software

version, and licensing information.

JRACKER WINDOW HELP

In the Resources pane and view pane, you use the tabs and buttons to access the tools
and options for a specific workflow.
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Customizing the Tracker user interface

You can customize the appearance of the Tracker window to suit your preferences,
using any of the following procedures. The Tracker window maintains these settings
until you adjust them again.

Undock and dock Resources or Communications panes

To undock Resources or Communications panes:

I Click the Dock Pane - button on the right side of the pane title bar.
To dock Resources or Communication panes:

I Double-click the pane title bar. The pane is docked in its last fixed position.

Change the position of the Resources or Communications
panes
1. Click and hold the pane title bar and drag the pane to the desired location in the
Tracker window.

2. Drop the pane anywhere in the window to change it into a floating pane.

Resize the Resources or Communications panes

1. Hover the mouse pointer over the inside edge of the pane or the top edge of a
section so that the pointer becomes a double-headed arrow and drag to resize as
needed.

2. Click and drag the arrow to move the split line left or right to resize the pane
width, or up and down to resize the section height.
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Hide or display the Resources or Communications panes

1. Click the Close Pane n button on the right side of the pane title bar.

2. From the Window menu, clear the required option to hide the Resources or
Communications pane and select the appropriate option to display the required

pane.

Hide or display sections within the Resources panes

I Click the Hide Section /] arrow or the Display Section - arrow to the right of the
section heading.

®@ Tip

The view pane cannot be undocked or repositioned in the Tracker window.
You can open a separate floating view pane by selecting the New floating
workspace option from the Window menu. This floating workspace can be
repositioned and resized.
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Mouse and keyboard shortcuts

You control Tracker using the mouse and keyboard:

Controlling Tracker's appearance and behavior

Use the following keys to control the way Tracker looks and behaves.

Task Keys
Display the Vicon Tracker help system F1
Display full screen view for the selected view pane F5
Display/Close Options dialog box F7
Pause/Restart real-time data streaming SPACE
Create named object from selected reconstructions CTRL+E

Moving the camera viewpoint

Use the mouse to move the camera viewpoint in 3D Perspective, 3D Orthogonal, and
Camera view panes.

Action Description Mouse

Dolly Move camera viewpoint closer to or Right-click + drag forward or

/Zoom further away from the focal point backward

Orbit Move camera viewpoint around the Left-click + drag left, right,
focal point forward, or backward

Truck Move camera viewpoint along a Click wheel button + drag left,

/Translate  horizontal or vertical axes right, forward, or backward
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Viewing the X- and Y-Axis

Use the mouse to view the x- and y-axis in a Graph view pane.

Action Keys and mouse

Slide x-axis left Click wheel button + drag left

Slide x-axis right Click wheel button + drag right
Slide y-axis up Click wheel button + drag forward
Slide y-axis down Click wheel button + drag backward
Z00m X-3xXis in Right-click + drag left

Zoom X-axis out Right-click + drag right

Zoom y-axis in Right-click + drag backward

Z00m y-axis out Right-click + drag forward

Zooming an axis (x ory)

All graph components in a single workspace maintain the same scale for both the x-and
y-axes. The x-axis is shared across all components, but each component has its own y-
axis. The y-axis may show different ranges, but represent the same number of values.

On the x-axis, the workspace is centered around zero, keeping the zero on the right
edge of the workspace and changing the values displayed on the left.
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Managing resources with Tracker

You manage the system components, calibration, objects, and recordings/playback of
your Vicon Tracker system in the Resources pane.

After you have prepared your Vicon system and selected the objects for motion capture
in the Resources pane, you use the view pane to view the data.

For more information, see the following topics:
I About the Resources pane on page 44

I About the System tab on page 47

I About the Calibrate tab on page 98

I About the Objects tab on page 110

I About the Recording tab on page 123

Vicon Motion Systems Ltd. 02-Nov-2016 Page 43 of 173



Tracker

‘ICON User Guide

About the Resources pane

The Resources pane enables you to manage the system components, calibration,
objects, and recordings/playback of your Vicon Tracker system.

The Resources pane contains the following components:

Component  Description

System tab Configure the components of your Vicon system.

Calibrate Calibrate your Vicon cameras.
tab
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Component  Description

CREATE CAMERA MAS

CALIBRATE CAMERAS
HIDE ADVANCED

5 Marker Wand & L-Frame ~

i §
=
2

AERA CALIBRATION

RESET

CALIBRATION FEE!

JAND COUNT i IROR  IMAGE ERRI

Objects tab  Manage object files for the objects whose motion data you want to

track.

RESOURCES [ 4

GO LIVE

PROPERTIES

Object Tracking

O

SecondObject,

ADD

Create Object:

rker To Object:
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Recording
tab

Resources
lists

Properties
pane

Vicon Motion Systems Ltd.

Save and play back recordings of trial data.

RE! ES

TRIAL NAME:

Filename:
First Frame:

Last Frame:

Unlabeled Trajectories:

T X
GO LIVE

B recoroms

LOAD TRIAL... REPROCESS TRIAL

HIDE ADVANCED

x\CapturedTrials\NewTrial.csv i

First Frame

None

]

START CANCEL

Select the nodes and any sub-nodes to be configured in the
Resources lists. The components of this list depend on whether you
are using the System or Objects tabs.

You view and change settings for the item selected in the Resources
list in the Properties pane. The contents of this pane depend on the
node selected in the Resources list.

02-Nov-2016

Page 46 of 173



Tracker

“ICON User Guide

About the System tab

RESD 5 o X

. COMMECTED GO OFFLINE

& ceecrs  Cre
UMNTITLED *
aystemn [100Hz]

Vicon |: dimeras

PROPERTIES

You manage the components of your Vicon system on the System tab. The System tab
may contain the following components:

Component Description

System You create, save, and manage configurations for the settings in the
configuration  System Resources pane using the configuration management
management  controls at the top of the pane.

System list You select the node for the system component you want to
configure in the System list;

I Local Vicon System The Vicon system capture rate and the
Tracker memory buffer size; real-time processing settings; and
the identification and connection settings for the Tracker host
PC.

I Vicon Cameras The identification and configuration settings for
each Vicon camera connected to your Vicon system.

I Vicon Connectivity The identification and configuration settings
for each Vicon Lock+, MX Giganet, MX Ultranet, and MX Ultranet
HD unit attached to your Vicon Tracker system.
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You can perform commands specific to a type of system component node or sub-node
by right-clicking on a node in the System list and selecting a command from the
displayed context menu.

You view or modify system components in the Properties pane. The properties
displayed depend upon the node selected in the System list.

Reorder Devices dialog box

To use the Reorder Devices dialog box to change the order in which Vicon devices are
displayed:

I On the System tab, right-click the Vicon Cameras node or Devices node and then
click Reorder.

In the Reorder Devices dialog box, choose from the following options:

Option  Description

Move Moves the selected item up one position in the list
Up

Move Moves the selected item down one position in the list
Down

Sort Sorts the list of devices according to name and type. Remembered devices
are at the bottom of the list.

Clean Removes the entries for the devices that are not used or referred to
(Remembered devices) in the current session.

Revert  Undoes all the changes you have made in this dialog box since you last
clicked OK.
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About the Local Vicon System node

R BES
. CONNECTED

UNTITLED *

Local Vicon Systern [100Hz]
Vicon Cameras

Devices

PROPERTIES

EM

MActual Frame R

Preferred Master:
Reboot All: REBOQOT ALL
Low Jitter:

Requested Frame Rate 2

GE ND TIMECODE
Genlock Standard:

Enable Genlock:

Timecode Source: m Internal -

Enable Timecode:

Detected Timecode: Maone

4

The Local Vicon System node enables you to configure the Vicon system capture rate
and the amount of memory allocated to Tracker for motion capture, manage the way
Tracker is to produce real-time 3D representations of the objects whose motion is

being captured, and specify the identification and connection settings for the Tracker
host PC.
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The Local Vicon System node is the top-level node that is displayed for the Tracker host
PC. This node contains sub-nodes for each device connected to your Vicon system
under the following nodes:

I Vicon Cameras
I Vicon Connectivity
I Devices

The node for the device designated as the Vicon system synchronization master is
highlighted in bold on the System tab in the Resources pane.

Set up Local Vicon System properties

To configure the Local Vicon System:

1. On the System tab, click the Local Vicon System node.

2. In the Properties pane, view or change settings for the desired properties to suit
the needs of your motion capture application.

When you first set up your Vicon system, you must configure at least the
Requested Frame Rate (Hz) property.

3. In the configuration management section, enter a name and click the Save

current configuration button to save your system configuration settings.

Properties pane for Local Vicon System

The Properties pane for Local Vicon System contains the following sections.
I System section on page 51

I Genlock and Timecode section on page 52

I Object Tracking section on page 55

I Reconstruction section on page 56

I UDP Stream section on page 57

I VRPN Stream section on page 58

You can also access related options from the Local Vicon System context menu on
page 59.
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System section

Actual Frame Rate [Hz):

Requested Frame Rate (Hz): _

Automatic
REBOOT ALL

Real Tirme Buffer Size (frames): -

Low Jittes:

On the System tab, when you click the Local Vicon System node, you can access the
following system-wide settings in the System section of the Properties pane. These
settings affect all the connected cameras and devices:

Setting Description

Requested The rate (in Hertz) at which to synchronize the Vicon cameras and the

Frame external video signal. Select from displayed values (multiples of the

Rate (Hz) base frame rate of the PAL, NTSC, or Film video standard specified in
Standard) up to a maximum of 2,000. The configured Vicon system
capture rate is displayed in square brackets beside the Local Vicon
System node. For example, if the Vicon system frame rate is set to 100
Hz, the node title is displayed as Local Vicon System [100Hz].

Actual Displays the frame rate currently used by the system, as constrained by
Frame the limits of the camera frame rate.

Rate (Hz)

Preferred If multiple connectivity devices are present in the system, enables you
Master to select your preferred master connectivity device. (If your system

contains a Vicon Lock+ connectivity device, this is automatically
selected as the master.)

Reboot All Resets all of the Vicon hardware devices in the Vicon system. Use this
button if a camera has failed to boot, or if you need to reset the whole
system for other reasons. Alternatively, select the Reboot Hardware
command from the context menu.
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Setting

Real Time
Buffer
Size
(frames)

Low Jitter

Description

The number of frames (between 1 and 100) that make up the buffer
between the Vicon hardware and the processing engine. If set to 1,
latency is minimized. If set to a higher value, throughput is improved,
but latency is higher.

When selected, sets the Grayscale Mode for all cameras to Only, which
is necessary to use jitter reduction, and applies advanced centroid
fitting and jitter reduction algorithms to reduce data noise.

Note that running in this mode increases sensitivity to bandwidth
limitations and the effectiveness of Low Jitter mode is related to
system size. For further information on its impact on your system,
contact Vicon Support.

Genlock and Timecode section

Genlock Standard

Enable Genlock

Enable Timecode:

Detected Timecode:

On the System tab, when you click the Local Vicon System node, you can access the
following settings in the Genlock and Timecode section of the Properties pane.

Setting

Genlock
Standard

Vicon Motion Systems Ltd.

Description

The type of video standard supported by the connected video source:
None, PAL, NTSC, Film, 30Hz and VESA (for a complete list, click the
Genlock Standard list in Tracker).

The icon to the left of each option provides additional information
about the availability of that standard.

Note: The 30Hz option enables you to run the Vicon system at
multiples of 30 frames per second (above 50 fps), with timecode and
genlock capability at true 30 fps, and works with both Vicon Lock+s,
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Setting

Enable
Genlock

Auto
Genlock

VESA
Offset

Timecode
Source

Vicon Motion Systems Ltd.

Description

and with Giganets and MX T-Series systems. However, note that for
30fps support to work with Tracker, you must upgrade the Vicon
firmware to Bundle 500.

Caution: Running at 30fps with Vicon systems older than MX T-Series is
not supported and is at your own risk.

Select to enable synchronization.

When selected, Tracker automatically selects a genlock standard and
enables synchronization based on currently detected signals.

Specify the system offset relative to the VESA signal (expressed as a
fraction of the VESA frame period). The camera timing can be offset by
up to one VESA frame.

Note: Only applies when you have selected one of the VESA standards
from the Genlock Standard list.

Enables you to select the required timecode source. The Internal Drop
option determines whether the internal timecode source generates 3
drop-frame timecode when the Genlock Standard is NTSC.

Note: VITC and LTC always display a flat line if the system is not
genlocked. This is because these signal types can only be detected by a
master device that is genlocked.
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Setting

Enable
Timecode

Detected
Timecode

Vicon Motion Systems Ltd.

Description

The icon to the left of each option provides additional information
about the availability of that standard:

lcon

&3

Cross

Flat
line

nnf
Blue

square
wave

Green
square
wave

i
Red
square
wave

Meaning

The standard is not supported by the hardware (that is, no
connected device supports locking to a signal of that type). If
you select an unsupported standard, it restricts the available
frame rates as it does in the previous version of Tracker.

No device in the system is detecting that standard.

The master device is detecting that signal and can genlock to
it.

If you select a8 mode with the blue wave icon and then select
the Enable Genlock check box, the icon turns green.

A device in the system is detecting the mode but a problem
prevents it from being used, for example, if the signal is being
detected by a device that is not the master device in the
system.

Select to enable timecode to be displayed in the Title bar when a live

system is connected.

Displays the currently detected timecode standard as the number of

timecode frames per second.
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Object Tracking section

sysem Wi Objectiter: (TSP

On the System tab, when you click on the Local Vicon System node, the following
settings are available in the Object Tracking section of the Properties pane.

Setting  Description

System-  Applies the selected filter to all objects. Choose between:

w@e I None: No filtering of any objects (unless object-specific filtering is
STJeCt applied - see Creating an object on page 112).
ilter

I Motion Model: Enables the ability to detect static objects. When
selected, Tracker outputs a constant position and orientation for an
object from the time it is detected as not moving to the time it resumes
motion. Use this option to clamp the position of an unmoving object to
its previous known position.

I Bias Tracking: Applies a smoothing filter that tracks systematic errors in
the camera measurements to minimize motion jitter when markers
become occluded in the camera views.
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Reconstruction section

NETRLUCTION

Emvironmental Dnft Tolerance:

Minimum Cameras to Start Traje.., _ L]

Reconstruction Minimum 5Separa... m-

On the System tab, when you click on the Local Vicon System node, the following
settings are available in the Reconstruction section of the Properties pane.

Settings Description

Environmental An uncertainty applied (in mm) to camera calibration to take into

Drift Tolerance account environmental factors such as temperature change, that
may cause drift in the calibration. For larger volumes, increase this
value; for smaller volumes, decrease this value.

For advice about reducing the effect of environmental factors,
see Prepare the capture environment on page 23.

Minimum Controls how many cameras (rays) must see the same marker

Cameras to (centroid) to create a new reconstruction and potentially form a

Start Trajectory new trajectory. The minimum value that can create a
reconstruction is two cameras. The maximum value of this
parameter is 50 camera rays. If there are a large number of
unlikely reconstructions being created, increase this value.

Tip : In Tracker 3, the default value for this property is 3 (ie three
cameras), so if you are using a two-camera system, ensure you
change the value to two before starting to work with Tracker.

Reconstruction  The minimum distance, specified as a value in the range 0-100

Minimum mm, allowed between 3D marker positions in order for them to be

Separation considered for reconstruction. If two candidate reconstructions
are closer than this minimum separation, only the most likely
reconstruction (in terms of the number of cameras contributing)
will be reported. The other will be discarded. A higher value
decreases the likelihood of creating spurious reconstructions, but
increases the possibility that some genuine markers will not be
reconstructed.

To disable this feature, set the value to 0.0.
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UDP Stream section

Enabled:

Data Block Size:

Object Per Port:

IP Address: localhost
Port: 51001

On the System tab, when you click on the Local Vicon System node, the following
settings are available in the UDP Stream section of the Properties pane.

Setting  Description

Enabled If selected, starts the UDP streaming of data. The UDP stream does not
maintain client connection information. If selected, data is output
whether or not there are any connected clients.

Data The size of the UDP datagrams (data blocks). Ensure the value selected
Block matches the expected value for the datagram size in the client program.
Size

Options are 256, 512, and 1024.

Object If cleared, all objects are output on the same port.

Per If selected, each object is output on its own UDP port. Port assignments

Port are made whether or not the object is active. The following image shows
how port numbers are assigned:

IP The network address used to broadcast the data.

Address

Port The starting port for UDP streaming. If Object Per Port is selected, this is

the starting port number. If Object Per Port is cleared, this is the output
port for all objects.
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NICON

VRPN Stream section

M 5TREAR

Add Filtered Tracker:

tion Min Cut-Off;

Rotation Beta:

On the System tab, when you click on the Local Vicon System node, the following
settings are available in the VRPN Stream section of the Properties pane:

Settings Description

Add If selected, adds a tracker (named <object>_2), with One Euro filtering

Filtered applied, to each object.

Tracker

Translation  Enables you to specify the frequency (Hz) below which noise

Min Cut- (translation motion) will not be filtered.

Off

Translation To avoid lag, you can set a value between 1and O to reduce filtration

Beta applied to the position of the object where there is greater motion. O
= filtering on all translation motion; 1 = filtering on very slow
translation motion only.

Rotatation  Enables you to specify the frequency (Hz) below which noise (rotation

Min Cut- motion) will not be filtered.

Off

Rotation To avoid lag, you can set a value between 1 and O to reduce filtration

Beta applied to the rotation of the object where there is greater motion. O

Vicon Motion Systems Ltd.

= filtering on all rotation motion; 1 = filtering on very slow rotation
motion only.
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Local Vicon System context menu

Local Vicon em [100Hz
System | 1 REBOOT HARD!

Vicon Cameras REBOCT CORE PROCESSOR Ctrl+R

RESYNCHRONIZE

REPROGRAM FIRMWARE

On the System tab, when you right-click on the Local Vicon System node, you can
select the following options from the context menu:

Option Description
Reboot Reset all of the Vicon hardware devices in the Vicon system. Use
Hardware this command if a camera has failed to boot, or if you need to reset

the whole system for other reasons.

Alternatively, use the Reboot All button in the System section of
the Properties pane.

Reboot Core Restarts the Core Processor and resets the labeler.
Processor Alternatively, press CTRL+R.

Resynchronize Forces the Vicon system synchronization master to resynchronize
the frame rate for all connected cameras and third-party devices.

Reprogram Display the Reprogram Firmware dialog box in which you can view
Firmware and update firmware for certain Vicon devices present in your
system.
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About the Vicon Cameras node

R BES

. CONNECTED

UNTITLED *
B Local Vicon System [100Hz]
E Vicen Cameras
B 2 ovx T160)
B 22 ovx T160)
B #6 mx T160)
B =0 ovx T160)
B 210 (mx T160)

B 213 (Mx T160)

PROPERTIES
IDENTIFIC
WET T
Device Id
SETTINI
Enabled

Strobe Intensity

Gain

Grayscale Mode

Enable LEDs

CENTROID FITTING
Th Id
Minimurm Circularity Ratio
Maximum Blob Height
CENTRC G
Enable Centroid Tracking

Marker Velocity

(@ Note

If your system includes only Vicon Vantage and/or Bonita cameras, the Gain
property is not displayed.

You manage the identification and configuration settings for each Vicon camera
connected to your Vicon system with the Vicon Cameras node.
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Configuring Vicon cameras ensures that all the camera settings are correct and
appropriate for your motion capture application. You can configure the settings for an
individual camera, several cameras, or all cameras at once.

This node is displayed under the Local Vicon System node. The Vicon Cameras node
lists each Vicon camera connected to your system. For each camera, the node name
includes:

I The device position number
I Any display name specified in the Identification property

I The camera type listed in parentheses, for example, #1 Over Door (T160)

Set up Vicon cameras
To configure Vicon cameras for optical data capture:
1. From the view pane tool bar, select Camera. The 2D data being captured by each

Vicon camera selected in the Resources pane in the System list is shown in a
separate Camera view pane.

2. View your capture volume in either of the following ways:

I In the Options dialog box, under the General View Options section, select the
Target Volume option. In the Camera view pane tool bar, from the View drop-
down list, select 3D Overlay. A virtual representation of your target volume is
overlaid on the 2D data from the camera image.

I Inthe capture volume, place a selection of static markers on the floor to
roughly outline your target capture volume.

3. In the System list in the Resources pane, select the Vicon camera node whose
properties you want to configure.

4. In the Properties pane, view or change settings for the relevant properties.
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When you first set up your Vicon system, you must configure at least the
following properties in the order shown:

Section Property Notes

Identification Name Only needed if you want to distinguish it from
the others

Settings Strobe If adjusting these two settings does not easily

Intensity enable you to eliminate reflections, create
camera masks to eliminate reflections and other

Centroid Threshold unwanted light sources that occur in parts of the
Fitting capture volume.
Settings Gain (MX T-Series only) Normally, leave at the default

x1 setting, but if the markers seem faint or if the
cameras have trouble distinguishing them, adjust
this setting as required.

Grayscale  Normally, leave at the default Auto setting.

Mode However, during focusing, it can be helpful to
change this setting to All, then change it back to
Auto as soon as the camera is focused.

These properties affect the quality of the motion capture data.
Therefore, it is important to optimize them before you collect data
intended for later analysis. In subsequent sessions, you may want to
configure additional properties to suit the needs of your motion capture
application.

5. When you have finished adjusting the Vicon Camera properties, in the Settings
area, ensure that Grayscale Mode is set to Auto.

6. At the top of the System tab, click the Save current configuration button to
save your system configuration settings to a .system file in one of the following
folders:
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I If you select Shared the file will be saved in C:
\Users\Public\Documents\Vicon\Tracker3.x\Configurations\Systems

I If you select Private it will be saved in C:
\Users\UserName\AppData\Roaming\Vicon\Tracker3.x\Configurations\Systems

Properties pane for a Vicon Cameras node

The Properties pane for a Vicon Cameras node or an individual camera node contains
the following sections.

I Camera Identification section on page 64
I Camera Settings section on page 65

I Centroid Fitting section on page 70

I Camera Status section on page 72

I Camera Hardware section on page 73

I Camera Firmware section on page 75

I Camera Calibration section on page 76

I Camera Commands section on page 76

You can also access related options from the Vicon Cameras context menu on page
77.

Vicon Motion Systems Ltd. 02-Nov-2016 Page 63 of 173



Tracker

“ICON User Guide

Camera ldentification section

Dewce Id: 19019

On the System tab, when you click on a Vicon Cameras node or an individual camera
node, the following controls are available in the Identification section of the Properties
pane:

Control  Description
Name A user-defined display name for the entire set of Vicon cameras or for
each individual Vicon camera. For example, if a camera is placed over a

door, you could name it Over Door .

Device The unique identification number Vicon assigns to each Vicon camera
ID during manufacture. The top-level entry for all Vicon cameras is read-only.
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Camera Settings section

I!
i

Grayscale Mode:

Enable L

Enable Dis
Enab
Enable Ac

HHHHi
%

(@ Note

The above illustration shows the Settings section for a Vicon Vantage camera.
The Settings section for other Vicon cameras displays slightly different
options.

On the System tab, when you click on a Vicon Cameras node or an individual camera
node, the following controls are available in the Settings section of the Properties

pane:
Control Description
Enabled Whether or not the Vicon camera is currently enabled for use.
Strobe The amount of light emitted by camera strobe units. This value can
Intensity be set between 0-1to minimize reflections and obtain clear marker

images. The higher the setting, the brighter the markers appear,
but this may cause blobs to be produced from reflections from
other strobes. Lower settings make the markers themselves less
visible to the cameras.

In almost all circumstances, you will want to keep the intensity at
its maximum level because the system works by recording light
from the strobes that is reflected from the markers, thus the more
light the strobes send out the more light the markers reflect.
However, if you are capturing a very fast moving object you may
achieve better results by reducing the strobe intensity. The strobe
intensity affects the time the strobe is on for each camera frame.
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Control

Gain

Grayscale
Mode

Vicon Motion Systems Ltd.

Description

The full strobe intensity corresponds to Tms (0.5ms with Bonita) for
normal frame rates. Lower strobe intensities mean that the markers
are captured with the strobes on for less time and, therefore, have
less time to move during the frame.

Tip: It is advisable to use full strobe intensity and deal with
reflection problems by closing the camera lens aperture. Adjust this
setting and the Threshold setting until reflections are minimized or
gone.

For further tips on setting Strobe Intensity, see Setting up a mixed
Vicon camera system on page 31.

(Vicon MX T-Series only) The amplification of the pixel value. Select
a displayed value to determine the intensity of the grayscale from
the Vicon cameras: x1, x2, x4, or x8. (Note that the available values
are those supported by the camera.)

This setting is applied to the camera to change the dynamic range
of the recorded image. Increasing the Gain means that the marker
has less variation in grayscale intensity between its center and its
edge, but in certain circumstances, using a higher gain yields
markers that are easier for the camera to distinguish.

Adjust this setting if the markers appear too faint or if the cameras
have trouble distinguishing them; otherwise, leave the this property
at the default x1 setting.

The type of data for processed grayscale blobs that the Vicon
cameras send to Vicon Tracker. (Note that this mode is disabled if
Low Jitter mode is selected.) The Vicon cameras perform data
processing to create 2D data for Vicon markers. They generate
grayscale blobs for reflections from objects in the capture volume
and then use centroid-fitting algorithms to determine which of
these are likely to be markers by comparing the shape of the
grayscale blobs to the Minimum Circularity Ratio and Maximum
Blob Height settings. During this processing, Vicon cameras can
produce the following types of data for grayscale blobs: centroids
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Control

Vicon Motion Systems Ltd.

Description

data (x, y coordinates and the radius of the centroid calculated),

grayscale data (pixel and line information), or coordinates data (line
information, that is, grayscale data without pixel values). However,
Bonita cameras do not perform centroid fitting.

You can specify which type of processed data Vicon cameras send
to Tracker:

Auto

None

All

Send grayscale data only of the grayscale blobs for which
centroids were not generated, that is, those below the
threshold specified for Minimum Circularity Ratio.

Send coordinates data of grayscale blobs for which one or
more line segments, or the total number of lines in the
blob, exceeds the value set for Maximum Blob Height.

If 3 marker can be centroid fitted by the camera, the
centroid is passed to the capture PC. If it cannot, the full
grayscale of the image is sent, allowing the data to be
post-processed on the PC. This is the default and
recommended mode.

Tip: If any optical camera does not capture wand data
during a wand wave, select the relevant camera on the
System tab and look in the Settings section of the
Properties pane to ensure you have set the Grayscale
Mode to Auto.

Send no grayscale data; send only centroid data (i.e, X, Y,
and radius data).

Any ambiguous grayscale data will be discarded.

Send grayscale data both of grayscale blobs for which
centroids were generated and of those for which
centroids were not generated, that is those below the
threshold specified for Minimum Circularity Ratio.

Send coordinates data of grayscale blobs for which one or
more line segments, or the total number of lines in the
blob, exceeds the value set for Maximum Blob Height.
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Control Description

Select this setting if you need to see exactly where the
camera calculates the centroid with respect to the
grayscale marker image, for example when adjusting
parameters. This setting results in much larger data rates
and files; it may be useful for diagnostic purposes, but do
not use it in normal capture situations.

Only Send all grayscale and coordinates data; send no centroid
data.

This setting is useful when focusing or making other
adjustments to the cameras themselves as you see
exactly the image recorded on the sensor.

Edges Send only edge coordinates data; send no centroid or
grayscale data.

If data rates are very high, for example when there are too
many reflections, the camera automatically enters this
mode. Use this setting to manually force the camera into
this mode.

No Send grayscale data both of grayscale blobs for which
Edges centroids were generated and of those for which
centroids were not generated; send no coordinates data.

Use this setting to prevent the Vicon camera from
sending edge coordinates.

Caution: Even if you have not specified a Grayscale Mode
setting that would have coordinates data sent to Tracker,
a Vicon camera automatically sends coordinates data -
either temporarily or permanently — if it is overloaded with
data (e.g., too many markers, too many reflections, hand or
reflective objects immediately in front of the camers, too
low a threshold or too high a gain). If a camera
automatically starts to present coordinates data, identify
the source of the overload and attempt to remedy it.
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Control

Enable LEDs

Enable
Display

Enable Tap to
Select

Enable
Accelerometry

Vicon Motion Systems Ltd.

Description

When selected, the status lights on the Vicon camera strobe unit
provide feedback on the status of the camera. (Bonita cameras do
not have status LEDs.) For more information, see the
documentation that was supplied with your Vicon camera.

(Vicon Vantage only) When selected, the OLED display on the
camera provides feedback on the status of the camera. For more
information, see the Vicon Vantage Reference PDF, supplied with
your Vicon Vantage cameras and available from the Downloads
page of the Vicon website.

(Vicon Vantage only) When selected, you can lightly tap the camera
in the volume to select it (and deselect the other cameras).

Note that when Enable Accelerometry is selected (see below), if
you tap a calibrated camera too hard, its status LEDs and OLED
display (if enabled) indicate that it has been 'bumped".

You can remove the camera's bumped status in Tracker. If thisis a
frequent occurrence, you can change its sensitivity to being tapped
by reducing the Bump Detection Sensitivity.

For information on removing a camera's bumped status and
changing Bump Detection Sensitivity, see Camera Status section
on page 72.

(Vicon Vantage only) When selected, the OLED display on
calibrated cameras changes to alert you when they have moved
from their calibrated positions, for example, if 3 camera has been
knocked.

In Tracker, the camera's Bumped check box (in its Status
properties) displays a check mark.

For information on removing a camera's bumped status and
changing Bump Detection Sensitivity, see Camera Status section
on page 72.

(This setting also turns on or off the auto-rotation of the display on
Vantage cameras.)
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Control Description

For more information on Vicon VVantage accelerometers, see the
Vicon Vantage Reference PDF, supplied with your Vicon Vantage
camera and available from the Downloads page of the Vicon
website.

Centroid Fitting section

Finermum C |rr_|_1|._-|r||.'_,.l Ratio:

Maximum Blob Height:

On the System tab, when you click on a Vicon Cameras node or an individual camera
node, the following controls are available in the Centroid Fitting section of the
Properties pane:

Control Description

Threshold  The minimum brightness (intensity) for markers; pixels of an intensity
lower than this threshold are ignored. This value can be set between O-
1to determine the pixels to be considered for centroid fitting onboard
the Vicon cameras. Lower settings enable the camera to detect lower
light levels, thus making the markers appear larger, but may pick up
unwanted reflections and other light sources. Higher settings reduce
the noise, but make the markers themselves less visible.

This setting differentiates between markers and ambient light. A Vicon
camera records 10-bit grayscale data, which for each sensor pixel is a
measure of how much light fell on that pixel during a given amount of
time. However, the cameras will almost always pick up some ambient
light in the volume. To enable the cameras to distinguish between light
that comes from markers and light that does not, a threshold is applied.
Anything above this threshold is deemed to be a marker, anything
below is deemed to be ambient light. A value in the region of 0.2 to 0.5
is usually appropriate, but Vicon strongly recommends that you use
static markers in the volume in order to establish an appropriate
setting. If cameras are evenly spaced around the volume, the same
threshold value is usually sufficient for all cameras.
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Control

Minimum
Circularity
Ratio

Maximum
Blob
Height

Vicon Motion Systems Ltd.

Description

Adjust this setting, the Strobe Intensity, and the camera's aperture
until reflections are minimized or gone.

Tip : To help you to determine the most effect threshold setting for
grayscale blobs, you can set the background color of the Camera view
pane to the value of the Threshold control in the Centroid Fitting
section of the Properties pane. To do this, open the Options dialog box
(F7), and in the General View Options, select Threshold.

The circularity threshold used by the centroid-fitting algorithms in a
Vicon camera. (Note that this mode is disabled if Low Jitter mode is
selected.)

This value can be set between 0-1to determine how similar a grayscale
blob must be to the internal model of a marker — that is a radially
symmetric object that has smooth, sharp edges and whose pixel
intensity is brightest at the center and gradually fades towards the
edges. The Vicon cameras consider grayscale blobs with circularity
equal to or greater than this threshold to be well-formed, circular
marker images. The higher the value, the more stringent the centroid
fitter is; the lower the value, the less stringent the centroid fitter is.
You may want to apply higher settings for camera calibration to ensure
that Tracker selects the best markers and thus provides the best
possible calibration. A lower value may be appropriate for data capture.

The maximum number of pixels per line that a grayscale blob can
contain in a horizontal line. If the number of pixels exceeds this value,
the Vicon camera determines that the grayscale blob is not a marker,
stops processing it, and discards the pixel values (it preserves just the
coordinates data, which can be sent to Vicon Tracker, depending on
the Grayscale Mode setting).

Set this value between 0-77500 to determine how large a grayscale
blob can be for a Vicon camera to consider it a candidate marker. The
Vicon cameras consider grayscale blobs with horizontal lines
containing this number or fewer pixels to be good-sized, circular
marker images. The higher the value, the larger a grayscale blob can
be; the lower the value, the smaller a grayscale blob must be.
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Camera Status section

Bump Detection Sensitivity:

(@ Note

The above illustration shows the Status section for a Vicon Vantage camera.
The Status section for other Vicon cameras displays fewer options.

On the System tab, when you click on a8 Vicon Cameras node or an individual camera
node, the following controls are available in the Status section of the Properties pane:

Control

Connected

Sync Master

Contributing
Centroids

Contributing
Grayscale

Contributing
Tracks

Vicon Motion Systems Ltd.

Description

Whether or not the Vicon camera is currently connected to the
Vicon system.

Whether or not the Vicon camera is designated as the
synchronization master for the Vicon system. (Not relevant for MX T-
Series cameras, MX devices with an Ultranet HD, or systems
containing a Vicon Lock or Lock+.)

Whether or not the Vicon camera is contributing centroid data
during the current motion capture.

Whether or not there is a socket open to the Vicon camera capable
of receiving grayscale. This socket may be dropped when the system
is under heavy load, therefore this property is useful as a system
status monitor. It is not related to Grayscale property in Settings.

Whether or not the Vicon camera is contributing tracks (that is,
labeling centroids between frames) during the current session.
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Control Description

Bumped Indicates the whether the Vicon Vantage camera has moved from its
calibrated position.

You can remove the Bumped status for:
I A selected camera: Clear the Bumped check box.

I All cameras: Press Ctrl+Shift+B

Bump Enables you to change the sensitivity of the Vicon Vantage camera's
Detection accelerometer (also see Enable Accelerometry in Camera Settings
Sensitivity section on page 65).

Camera Hardware section

Senal Humber:

IP Address:

Destination [P Address

(D Note

The above illustration shows the Hardware section for a Vicon Vantage
camera. The Hardware section for other Vicon cameras displays fewer options.
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On the System tab, when you click on a8 Vicon Cameras node or an individual camera
node, the following controls are available in the Hardware section of the Properties

pane:
Setting Description
Type The type of Vicon camera (Vantage, Bonita, T160, T40 or T20). The

Vicon Cameras node is read-only.

Strobe Type The type of strobe unit attached to the front of the Vicon camera:
Visible Red (VR), Near Infrared (NIR), or Infrared (IR). MX T-Series
T160, T40, and T20 cameras support only VR and NIR strobe units.

Bonita cameras support NIR.

For a Vicon Cameras node, this setting is read-only.

Strobe Displays data from Vicon Vantage strobe onboard sensor both as a

Temp numeric indicator (in degrees Celsius) and a colored temperature
indicator. The color of the indicator changes to reflect a change in
temperature: yellow (warming up to the temperature specified by the
lower bounds), green (between the specified upper and lower
bounds) or red (overheated above the upper bounds).

To set values that are representative of your laboratory environment,
you can change the upper and lower bounds of the temperature
range. To do this, select the Camera Temperature Range option in the
Options dialog box (F7).

Camera Displays data from Vicon Vantage camera body onboard sensor. See
Body Temp Strobe Temp above.
1

Camera Displays data from Vicon Vantage camera body onboard sensor. See
Body Temp Strobe Temp above.

2

Sensor The width (in pixels) of the Vicon camera sensor.

Width
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Setting Description

Sensor The height (in pixels) of the Vicon camera sensor.

Height

Revision Camera revision number.

MAC The Media Access Control (MAC) address assigned to the Vicon
Address camera during manufacture. This is a hexadecimal value in the format

#ERHE AR AR AR AHE

For a Vicon Cameras node, this setting is read-only.

Serial Vicon Vantage camera's serial number (if set)
Number

IP Address The Internet Protocol (IP) address assigned to the Vicon camera on
the Vicon Ethernet network.

For a Vicon Cameras node, this setting is read-only.

Destination  The network adapter IP address to which data from this camera will
IP Address be sent.

Camera Firmware section

Firmware Complete:

On the System tab, when you click on a Vicon Cameras node or an individual camera
node, the following controls are available in the Firmware section of the Properties

pane:
Control Description
Firmware The version number of the Vicon firmware currently installed on the
Version Vicon camera.
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Control Description
Firmware Whether or not the currently installed Vicon firmware is complete. If
Complete not, you can reprogram the firmware.

Camera Calibration section

Reset Calibration: RESET CALTBRATION

Focal Length (mm):

On the System tab, when you click on a Vicon Cameras node or an individual camera
node, the following controls are available in the Calibration section of the Properties
pane:

Control Description

Reset Calibration  Reset calibration of selected camera(s)

Focal Length The camera lens focal length value of the selected camera(s) in
(mm) mm.

Camera Commands section

On the System tab, when you click on a Vicon Cameras node or an individual camera
node, the following command is available in the Commands section of the Properties
pane:

Command Description

Reboot Stop and restart all cameras or the selected Vicon camera.
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Vicon Cameras context menu

When you right-click on the Vicon Cameras node on the System tab, you can select
from the following options on the context menu:

Option

Reorder

Reboot
All
Cameras

Remove
Vicon
Cameras

Enable
Preview
Mode

Description

Display the Reorder Devices dialog box. This enables you to change the
order in which Vicon cameras are displayed in the System Resources
list.

Stop and restart all the Vicon cameras in the system.

Displays a choice of Disconnected or Missing:
I Disconnected - removes cameras that are currently unplugged.

I Missing - removes cameras that are unplugged, but were previously
used in a calibration.

Displays a 'video' image from the optical sensor of an MX T-Series
camera. This enables you to aim cameras more quickly and easily during
setup.

Note: This preview feature is for system setup purposes only. You
cannot capture camera data in Preview mode.

When you right-click on a node for a specific Vicon camera, you can select the

following option from the context menu:

Option Description
Reset Calibration Resets the camera calibration
Reboot Stop and restart the selected Vicon camera.

Vicon Motion Systems Ltd.
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About Vicon connectivity units

You configure Vicon connectivity units — smart boxes that can be combined to create
a distributed architecture, enabling you to customize the number of Vicon cameras and
supported third-party devices in your Tracker system — with the Vicon Connectivity
node on the System tab.

The Vicon Connectivity node is displayed under the Local Vicon System node when
Vicon Tracker is connected to the Vicon system. The Vicon Connectivity node lists each
Vicon connectivity unit connected to your Vicon system.

Depending on the type of Vicon system under which you are running Vicon Tracker,
your Vicon system architecture will contain one or more of the following Vicon
connectivity units:

I Vicon Lock+- connectivity unit that facilitates the integration of synchronous third-
party equipment with Vicon Vantage and Vicon Bonita cameras by providing or
receiving synchronization and/or timecode. It also provides connectivity for third-
party analog capture sources, such as force plates, EMG equipment, and generic
devices.

I MX Giganet - the primary connectivity unit in an MX T-Series and/or Bonita system.
I MX Ultranet - the primary connectivity unit in an MX+ system.
I MX Ultranet HD - the primary connectivity unit in an MX F-Series system.

You can incorporate units and components from MX T-Series systems into your Vicon
VVantage system. For details on configuring a combined architecture, see the Vicon
Vantage Reference or Go Further with Vicon MX T-Series reference, or contact Vicon
Support.
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About Vicon Lock+ units

Vicon Lock+ provides synchronization and timecode to Vicon Vantage and Vicon Bonita
cameras. It also provides connectivity for third-party analog capture sources, such as
force plates, EMG equipment, and generic devices.

The use of Vicon Lock+ is supported for Vicon Vantage and Vicon Bonita camera
systems and in integrated T-Series and VVantage systems.

This node is displayed under the Local Vicon System node when Vicon Tracker is
connected to a Vicon system with at least one Vicon Lock unit. The Vicon Connectivity
node lists each Vicon Lock+ unit connected to your Vicon system.

For more information about Vicon Lock+ units, see;
I Properties pane for Vicon Lock+ units on page 80
I Vicon Lock+ context menu on page 81

I Vicon Lock+ Quick Start Guide (PDF)
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Properties pane for Vicon Lock+ units

The Properties pane for Vicon Lock+ nodes contains the following sections.

I Vicon Lock+ Identification section on page

I Vicon Lock+ Status section on page

I Vicon Lock+ Sync Out section on page

You can also access related options from the Vicon Lock+ context menu on page 81.

Vicon Lock+ Identification section

If a Vicon Lock+ is connected to your Vicon system, when you click on the relevant
Vicon Connectivity node on the System tab, the following controls are available in the
Identification section of the Properties pane:

Setting

Name

Type

Device ID

Description

A user-defined display name for the Vicon Lock+.

The Lock type is read-only.

The Device ID is read-only.

Vicon Lock+ Status section

On the System tab, when you click on a Lock+ node, the following controls are available
in the Status section of the Properties pane:

Setting

Enabled

Sync
Master

Vicon Motion Systems Ltd.

Description

Whether or not the Vicon Lock+ is currently enabled for use.

The Vicon Lock+ automatically becomes the synchronization master for
the Vicon system.
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Vicon Lock+ Sync Out section

General Purpose Outputs (GPO) enable you to configure your system to trigger external
equipment on or around each camera frame sync pulse. Other GPO functionality,
available with other Vicon software, is not implemented with Vicon Tracker.

For further information, see the PDF Vicon Lock+ QuickStart Guide. For up-to-date
information about the types of GPO triggers that are supported, contact your local
Vicon Support office (for Vicon contact details, see Contact Vicon on page 173).

Vicon Lock+ context menu

If a Vicon Lock+ is connected to your Vicon system, when you right-click on the Vicon
Connectivity node on the System tab, you can select the following options from the
context menu:

Option Description

Reorder Display the Reorder Devices dialog box in which you can change the
order in which Vicon Lock+ units are displayed on the System tab.

Reboot All Stop and restart all of the Vicon Lock+ units in the Vicon system.
Vicon
Locks

When you right-click on a node for a specific Vicon Lock+, you can select the following
options from the context menu:

Option Description

Reboot Stop and restart the selected Vicon Lock+,

Reset Timecode Reset the Timecode to 00:00:00:00.
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About MX Giganet units

Forinformation on MX Giganet nodes, see the following topics:
I Set up MX Giganet units on page 82

I Properties pane for MX Giganet nodes on page 83

I MX Giganet context menu on page 86

You can incorporate components from MX T-Series systems into a Vicon Vantage
system by connecting the MX Giganet to the primary PoE+ unit of the Vantage system.
For details of cameras and units that can be incorporated in an integrated Vantage and
MX T-Series system, see Tracker system components on page 25.

Set up MX Giganet units

The Vicon Connectivity node is displayed under the Local Vicon System node when
Vicon Tracker is connected to a Vicon system with at least one MX Giganet unit. The
Vicon Connectivity node lists each MX Giganet unit connected to your Vicon system.
For each MX Giganet, the node name includes the device position number, any display
name specified in the Identification property, and the device type listed in parentheses,
e.g, #1 Name (MX Giganet).

To configure MX Giganet units for analog data acquisition:

1. On the System tab, select the node whose properties you want to configure:
I Vicon Connectivity node for all MX Giganet units.

I A sub node for a specific MX Giganet unit — For Vicon MX systems, the MX
Giganet sub-nodes in the System list correspond to the IDs assigned by
Tracker. If an MX Giganet unit has automatically been designated as the
synchronization master for the Vicon system, its node name is displayed in bold.
The colored icon beside an MX Giganet node identifies its status:

I Green play button: Component OK (active or connected). If an analog device
is connected, this status does not reflect the analog device's status.

I Yellow pause button: Component is not fully set up or device has been
disabled in the Status section of Properties.

I Red stop button: Component down (unavailable or disconnected).
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2. In the Properties section, view or change settings for the required properties.
When you first set up your Vicon system, you configure at least the Name
property and, if you are using synchronization functionality, the Sync Out
properties. In subsequent sessions, you may want to configure additional
properties to suit the needs of your motion capture application.

3. In the configuration management area at the top of the System tab, click the

save button H to save your system configuration settings to a .system file.

Properties pane for MX Giganet nodes

The Properties pane for MX Giganet nodes contains the following sections.
I MX Giganet Identification section on page 83

I MX Giganet Status section on page 84

I MX Giganet Sync Out section on page 84

I MX Giganet Hardware section on page 85

I MX Giganet Firmware section on page 85

I MX Giganet Commands section on page 86

You can also access related options from the MX Giganet context menu on page 86.

MX Giganet Identification section

If MX Giganets are connected to your Vicon system, when you click on the Vicon
Connectivity node on the System tab, the following controls are available in the
|dentification section of the Properties pane:

Setting Description
Name A user-defined display name for the entire set of MX Giganets.
Type The Vicon Connectivity node is read-only.

Device ID The Vicon Connectivity node is read-only.

When you click on an individual MX Giganet node on the System tab, the following
controls are available in the Identification section of the Properties pane:

Vicon Motion Systems Ltd. 02-Nov-2016 Page 83 of 173



Tracker

“ICON User Guide

Setting Description

Name A user-defined display name for the selected MX Giganet.

Type The MX device type.

Device The unique identification number Vicon assigned to the MX Giganet
ID during manufacture.

MX Giganet Status section

On the System tab, when you click on an MX Giganet node, the following controls are
available in the Status section of the Properties pane:

Setting Description

Connected Whether or not the MX Giganet is currently connected to the Vicon

system.
Enabled Whether or not the MX Giganet unit is currently enabled for use.
Sync Whether or not the MX Giganet is designated as the synchronization
Master master for the Vicon system.

MX Giganet Sync Out section

General Purpose Outputs (GPO) allow you to configure your system to trigger external
equipment on or around each camera frame sync pulse.

Other GPO functionality, available with other Vicon software, is not implemented with
Vicon Tracker.

For further information, see the hardware manual for your Vicon Giganet. For up-to-
date information about types of GPO triggers that are supported, contact your local
Vicon Support office (for Vicon contact details, see Contact Vicon ).
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MX Giganet Hardware section

On the System tab, when you click on the Vicon Connectivity node or on an MX Giganet
node, the following controls are available in the Hardware section of the Properties
pane:

Setting  Description

MAC The Media Access Control (MAC) address assigned to the MX Giganet
Address during manufacture. This is @ hexadecimal value in the format ##. ##.##.
#Ht## A
The Vicon Connectivity node is read-only.

IP The Internet Protocol (IP) address assigned to the MX Giganet on the
Address Vicon MX Ethernet network.
The Vicon Connectivity node is read-only.

MX Giganet Firmware section

On the System tab, when you click on an MX Giganet node, the following controls are
available in the Firmware section of the Properties pane:

Setting Description

Firmware The version number of the firmware currently installed on the MX
Version Giganet.

Firmware Whether or not the currently installed firmware is complete. If not,
Complete you can reprogram the firmware.
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MX Giganet Commands section

On the System tab, when you click on an MX Giganet node, the following command is
available in the Commands section of the Properties pane:

Command Description

Reboot Stop and restart the MX Giganet.

MX Giganet context menu

If MX Giganets are connected to your Vicon system, when you right-click the Vicon
Connectivity node on the System tab, you can select these options from the context

menu:
Option Description
Reorder Display the Reorder Devices dialog box in which you can change the
order in which MX Giganets are displayed on the System tab.
Reboot All Stop and restart all of the MX Giganets in the MX system.
MX
Giganets

When you right-click a node for an MX Giganet, you can select the following options
from the context menu:

Option Description

Reboot Stop and restart the selected MX Giganet.

Reset Timecode Reset the timecode to 00:00:00:00.
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About the Devices node

The Devices node is displayed under the Local Vicon System node when licensed
additional devices (that is, connected devices that are not cameras or connectivity
devices) are connected to the Vicon system. The Devices node lists each additional
type of device that is connected to your Vicon system.

You can only use an additional device if you have the required license. To check your
current licensing options, from the Help menu, click About Vicon Tracker and in the
window, click the Feature Details button. After a few seconds, the currently licensed
options are listed. To change your licensing options, contact Vicon Support.

Depending on the type of additional licenses you are using with Tracker and your Vicon
system, it may contain one or more of the following additional devices:

I Analog device such as accelerometers (see Set up analog devices on page 87).
I Dikablis Eye Tracker (see About eye tracking on page 88).

I Vicon Apex (see About Vicon Apex devices on page 93).

Set up analog devices

The Devices node is displayed on the System tab under the Local Vicon System node
when Vicon Tracker is connected to a Vicon system with at least one additional device
(a device that is not a camera or a connectivity unit).

Analog devices such as accelerometers are connected to the Vicon system via an MX
Giganet or Vicon Lock. You add analog devices to the Vicon system by right-clicking on
the Devices node and selecting Add Generic Analog.

The Generic Analog node enables you to select the appropriate options for your device.

You can only use an analog device with Tracker if you have the required license. For
more information, contact Vicon Support.

To use an analog device with Tracker:
1. Ensure that the analog device is connected to your Vicon system through a
Giganet or Vicon Lock+.

2. In Tracker, on the System tab, right-click Devices, point to Add Analog Device,
and then click Add Generic Analog. A Generic Analog device appears beneath
Devices.

3. Right-click Generic Analog and from the list, select your analog device.
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4. To add outputs for the device, on the System tab, right-click the device and click
the number of components to add.

5. To change the properties of the output, edit the appropriate property in the
Properties pane, for example:

Name

A scaling factor from the voltage input to desired output
Analog input pin

Channel gain

6. To change the options for viewing data in the Graph view, in the view pane,
select Graph and then choose the appropriate option from the menu.

®@ Tip

You can receive the raw analog data and relevant device information through
the DataStream SDK.

About eye tracking

With Tracker, you can use the Dikablis Eye Tracking System to track movement of the
eye's pupil to calculate the gaze vector.
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The Dikablis Eye Tracking System is compatible with both T-Series and Bonita cameras.
A minimum of two cameras are required for use with the system.

(D Note

Eye tracking is not available with the evaluation license, but is an optional add-
on to the full version of the software and requires an additional license.

Calibrating and integrating eye tracking

To calibrate your system and use Tracker to track eye movement, complete the
following procedures:

I Calibrate the Dikablis system and connect it to your Vicon system on page 89
I Calibrate your Vicon system and add in your Dikablis device on page 90

I Specify the eye offsets on page 91

I Calibrate the Dikablis eye tracker with Vicon Tracker on page 92

I Save your settings on page 92

Calibrate the Dikablis system and connect it to your Vicon system

1. Connect up the headset, transmitters and receivers that comprise the Dikablis
eye tracking system.

2. Ensure the subject is wearing the Dikablis headset and some markers for head
tracking.

3. Start the Dikablis Recorder software on the Dikablis system and run the
calibration wizard.

4. Connect the Dikablis laptop directly to your Vicon system PC with an Ethernet
cable.

5. Set the IP addresses of the Network Interface Cards to an appropriate value.
These instructions use 10.0.0.1 on the Dikablis laptop and 10.0.0.2 on the Vicon
system PC. (For instructions on how to set IP addresses, see the online help for
Windows.)
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Calibrate your Vicon system and add in your Dikablis device

1. Aim your Vicon cameras to capture the required volume.
2. Calibrate the cameras in Tracker (see Calibrate Vicon cameras on page 100).

3. Setyour origin pointing forwards by positioning the T of the wand with the flat
part (the top of the T) facing towards the front of the capture volume.

4. When you have a calibrated system, create an object in Tracker from the wand
markers. To do this:

a. Inthe Resources pane, click the Objects tab and ensure that in the Object
Tracking Mode section at the bottom of the tab, Track mode is not
selected. This enables you to see unlabeled reconstructions in the 3D
Perspective view pane.

(@ Note

Viewing unlabeled reconstructions requires additional processing,
so for lowest output latency, when you have finished creating
objects, click the Track button to change to Track mode. When
Track mode is selected, the Track button is green.

b. In the 3D Perspective view pane, ALT+click and drag to select the markers.

c. In the Resources pane, click the Objects tab and in the Create Object box,
type Wand and then click Create .

5. Adjust the wand's origin so it is on the center marker on the cross of the T.

6. With your subject looking straight ahead, create an object from the head markers
and give it a suitable name, such as Head . (You can give it any suitable name,
but ensure you use the same name in the following steps.)

7. On the System tab, right-click Devices, point to Add Digital Device, and then click
Add Dikablis Eye Tracker.

8. Select the Dikablis Eye Tracker and in the Properties pane, enter these values:
I Name: Eye
I Head Object: Head

I IP Address: 10.0.0.1 (or the address of the PC running the Dikabilis software if
different from 10.0.0.7)

I Calibration Object: Wand
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Make sure the Eye Tracker remains selected on the System tab, change the view
pane to Graph view and in the Components list, select Components.

Two graphs are shown: X and Y, representing the 2D coordinates for the eye's
gaze. The values are pixel values from the eye camera.

Check that the eye's gaze is accurately represented by the X and Y values. To do
this:

a. Getyour subject to look left. The X value decreases.

® Tip

To see all the data, you may need to click the Scale the graph to

e
T

fit the horizontal and vertical ranges of data button &
top of the Graph view pane.

at the

b. Get your subject to look right. The X value increases.
c. Getyour subject to look up. The Y value increases.

d. Get your subject to look down. The Y value decreases.

® Tip

The X values should not go above 640 or below O. The Y values should
not go above 480 or below 0.

Specify the eye offsets.

Specify the eye offsets

1.

3.

With the Eye Tracker selected on the System tab, in the Properties pane, enter
appropriate values. The following offsets are normally suitable:

I X (mm):-20
I Y (mm):-40

I Z(mm): -25

. Change the view pane to 3D Perspective and look at the Head object.

The eyeball should be approximately where the eye is, relative to the Head
markers.

Calibrate the Dikablis eye tracker with Vicon Tracker.
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Calibrate the Dikablis eye tracker with Vicon Tracker

1. Get your subject to stand with the wand in their hand so that both the Head and
Wand objects are clearly and consistently visible in the 3D Perspective view
pane.

2. Get the subject to look at the marker at the center of the T on the wand.

3. Inthe Calibration area of the Eye Tracker Properties pane, click Add.
The Samples box displays 1.

® Tip

If an error is made during calibration, you can remove the last sample
you added by clicking the Remove button.

4. Get the subject to move the wand and repeat step 3.
The number of samples goes up to 2.
5. Repeat step 4.

The number of samples goes up to 3 and an eye with an eye vector coming from
it appears in the 3D Perspective view pane.
In the Calibration area of the Properties pane, 3 Residual value is displayed.

6. Get your subject to keep their head still and move the wand around, following
the marker at the center of the T with their eyes.

In the 3D Perspective view pane, the eye vector now follows the wand.
7. On the System tab, select the Eye Tracker. Change the view pane to Graph.
Ray X, Ray Y and Ray Z values are displayed, as well as X and Y values.

8. Save your settings.

Save your settings

1. On the System Resources pane, click the Configuration menu button E and
select Save As.

2. Enter the name DikablisTest.

3. When prompted, select Shared or Private.
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About Vicon Apex devices

You can only use an Apex with Tracker if you have the required license. To check your
current licensing options, from the Help menu, click About Vicon Tracker and in the
window, click the Feature Details button. After a few seconds, the currently licensed
options are listed. To change your licensing options, contact Vicon Support.

To add an Apex to your Vicon system:

1. Complete the following steps in the order shown:

a. Ensure the Apex is sufficiently charged (see the Vicon Apex User Guide)
and switch it on in the capture volume.

b. Plug the Apex's bluetooth dongle into the relevant computer.
c. Start Tracker.

2. After a few seconds, on the System tab, right-click the Devices node, click Add
Apex Device, and in the Add Apex Devices dialog box, select the required device
and click Add.

On the System tab, the selected Apex is displayed under the Apex Device node.

3. To display all the Apex settings, ensure the Apex is selected on the System tab
and if necessary, at the top right of the Properties pane, click Show Advanced.

The following controls are available in the Properties pane:

Section Control Description

General Name A name that uniquely identifies the selected Apex.
The default name is of the format ViconAP_nnn. If
required, you can change the name of the Apex.

Delay An adjustment (in seconds) to allow for any delay in
Compensation the datastream. The defaultis O.
(s)

LED Intensity Enables you to change the brightness of the LEDs.
The default is 2; the brightest setting is 3.
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Section

Vicon Motion Systems Ltd.

Control

Continuous
Mode

Sleep

Sleep Timeout
(min)

Status

Indicators

Identify

Orientation

Haptic
Feedback

Filtering Type

02-Nov-2016

Description

Enables you to change the LEDs to be on
continuously, instead of being strobed. If you select
this setting, to reduce power consumption, the LED
Intensity is automatically set to 1. For further
reduction of power consumption, see also Sleep and
Sleep Timeout (below).

When selected, enables the device to turn off the
tracking LEDs after the number of minutes of
inactivity specified in the Sleep Timeout box.

If Sleep is selected, enables you to specify the
number of minutes of inactivity by the joystick or
buttons after which the tracking LEDs are turned
off. To reactivate the LEDs, touch the joystick or
buttons.

If cleared, the two flashing status LEDs on the top of
the Apex are switched off. Requires updated device
firmware 3RC.

Causes the selected Apex to vibrate, enabling it to
be easily identified.

Enables you to select from orientation options for
the device coordinate system.

If selected, every time you press any of the five
buttons on the Apex device, it vibrates briefly.
Requires updated device firmware 3RC.

Enables you to specify the filtering type for the
selected Apex device. For more information on
filtering types, see Creating an object on page 112,
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Section Control Description

Information Serial Number  The four-digit serial number of the Apex. This
number is also visible on a sticker on the device.

Bluetooth The Bluetooth serial number of the Apex.
Identity

PCB Revision The hardware revision number of the Apex.

Mechanics The mechanics code of the Apex.

Revision

Firmware The firmware revision number of the Apex.
Revision

For more information, see:
I Set up Vicon Apex devices on page 95

I Using multiple Vicon Apex devices on page 97

Set up Vicon Apex devices

To start the Apex, ensure it is sufficiently charged (see the Vicon Apex User Guide) and
its bluetooth dongle is plugged into the relevant computer, then switch it onin the
capture volume. The LEDs on the Apex flash until it is synchronized with the cameras.

You will only be able to use an Apex with Tracker if you have the required license. For
more information, contact Vicon Support.

To set up an Apex to work with Tracker:

1. Ensure Tracker is booted up, the Apex's bluetooth dongle is plugged in and the
Apex is charged and switched on.

2. To add the Apex to the current configuration, on the System tab in the Resources
pane, right-click Devices and then click Add Apex Device.

3. In the Add Apex Devices dialog box, select the device to add and click Add.
After a few seconds, the Apex appears on the System tab. Its name is displayed
in the General area of the Properties pane.

In the capture volume, the tracking LEDs on the device illuminate and object
tracking begins.
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4. To check that the Apex is working correctly, in the view pane, select Graph view
and operate the joystick and buttons. The graphs show the current status of the
joystick (the top two graphs are the x and y views) and the buttons.

5. To change the way the Apex works, use the relevant control in the Properties

Vicon Motion Systems Ltd.

Change the orientation of the device's coordinate system

pane:

To do this Use this
control

Make the LEDs brighter or dimmer LED
Intensity

Change the LEDs to be on continuously Continuous
Mode

Turn on or off the tracking LEDs after the number of minutes Sleep

specified in the Sleep Timeout box.

If Sleep is selected, specify the number of minutes of inactivity Sleep

by the joystick or buttons after which the tracking LEDs are Timeout

turned off. To reactivate the LEDs, touch the joystick or (min)

buttons.

Turn the status indicator LEDs on or off Status
Indicators*

Orientation*

Use haptics to identify an Apex in the capture volume ldentify
Cause the Apex to vibrate briefly whenever one of its buttons Haptic

is pressed Feedback*
Change the filtering that is applied to the selected Apex Filtering
device. For more information on filtering types, see Creating an  Type*

object on page 112.

* Requires updated device firmware 3RC
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6. To enable Tracker to remember the device that you have added in future
sessions, save the current configuration, using the configuration management
controls at the top of the System tab.

& CALIBRATE |~ ¥

Using multiple Vicon Apex devices

You can use up to seven Apex devices simultaneously: each device comes with a
unigue name and color that identifies it within Tracker. If required, you can change this
name. When the device is selected on the System tab, the name appears in the General
section of the Properties pane.

You can also use the Identify button in Tracker to quickly identify a selected Apex.

To quickly identify an Apex:

1. Ensure that the Apex is switched on and connected in the capture volume.
2. In Tracker, on the System tab, click one of the Apex devices to select it.

3. Inthe Properties pane, go to the General section and click Identify.
The selected Apex vibrates, enabling you to identify it.
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About the Calibrate tab

CALIBRATE CAMERAS

Calibration Type: Full Calibration

Cameras To Calibrate: All Cameras

Refinement frames: 1000
Wand Ratio Tolerance:
Wand Straightness Tolerance:

Use 5 Marker Wand:

RESET OAD... SAVE...

CAMERA CALIERATION FEEDE

CAMERA WAND COUNT ~ WORLD IMAGE ERR!

Calibration is a two-stage process by which Vicon Tracker calibrates the cameras based
on specialized calibration objects (whose dimensions and relative marker positions are
known):

1. Calibrating cameras During the first stage, the Tracker camera calibration
process calculates the physical position and orientation of each Vicon camera in
the capture volume based on the movement of the calibration object. Tracker
uses this information to determine each camera's physical position and
orientation in the capture volume and correct for any lens distortion.
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2. Setting volume origin During the second stage, you set the volume origin in
Tracker. Tracker measures the position of the calibration object and uses this
information to identify the origin of the world and its horizontal and vertical
axes. These volume origin and axes are referred to as the global coordinate
system. The global axes coordinates are given in the form (x, y, z), where x is 3
horizontal axis, y is the horizontal axis perpendicular to x, and z is the vertical
axis.

The Calibrate tab contains the following sections:

Section Description

Create Automatically create cameras masks to obscure all reflections visible
Camera to the Vicon cameras. For more information, see Creating camera
Masks masks automatically on page 147 and Creating camera masks

manually on page 148.

Calibrate Calibrate the Vicon cameras to determine their positions, orientations,

Cameras and lens properties, which enables Tracker to produce accurate 3D
data from motion data captured throughout the capture volume. For
more information, see Calibrate Vicon cameras on page 100,

Set Define the global origin and the axes of the world (in the context of
Volume the capture volume). For more information, see Calibrate Vicon
Origin cameras on page 100.

Manage Reset, load, or save camera calibration defining settings for the Vicon
Camera cameras in your Tracker system. For more information, see Calibrate

Calibration  Vicon cameras on page 100.

Camera View system calibration processing progress and status information.
Calibration  For more information, see Calibrate Vicon cameras on page 100.
Feedback
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Calibrate Vicon cameras

You specify settings for the calibration of Vicon cameras on the Calibrate tab, in the
Calibrate Cameras section.

The Vicon camera calibration process describes the capture volume to the system,
enabling Tracker to determine the positions, orientations, and lens properties of all the
Vicon cameras. Tracker uses this information to produce accurate 3D data. During the
camera calibration process, Vicon Tracker creates a calibration parameters (xcp) file.
This file contains the calibration settings and threshold data specified for the Vicon
cameras in your Tracker system and is used when data from these cameras is
processed. An .x2d file containing the latest calibration data, of the format
LatestCalibration yyyymmddnnnnnn.x2d, is also saved in the same location as the .x2d
containing the recorded trial data.

As part of the first stage of the daily Tracker motion capture workflow, Vicon
recommends that you calibrate your Vicon cameras each day before you
capture any data. This ensures that any unexpected changes in your setup
that may have occurred when the system was unsupervised will not influence
the quality of your data. You can perform the level of camera calibration that
suits your requirements: a full camera calibration or a calibration refinement
(for more information, see Understanding calibration types on page 104).

To perform a Vicon camera calibration, you need a dynamic calibration object, which is
supplied with your Vicon system.

To calibrate Vicon cameras in Tracker:

1. Do one of the following:

I If you want to calibrate only some of the cameras, on the System tab in the
Resources pane, expand the Vicon Cameras node and select the Vicon
cameras that you want to calibrate;

or
I If you want to calibrate all cameras, go straight to the next step.

2. On the Calibrate tab, expand the Calibrate Cameras section and from the Wand
drop-down list select the type of dynamic calibration object you are using.
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3. View or change the settings for the required parameters (if required, click Show
Advanced to reveal additional settings), ensuring that you select the appropriate
option from the Calibration Type list; Full Calibration or Calibration Refinement.

® Tip

If you have already performed a full calibration, Calibration Refinement
is selected by default, as this will normally be the most appropriate
option. (For more information, see Understanding calibration types on
page 104.)

4. In the Calibrate Cameras section, click Start.
All Vicon cameras are selected and a separate Camera view pane is displayed for
each one. The camera calibration process starts, and the Start button switches
to its Stop setting.

5. In the capture volume, wave the calibration wand throughout the area where you
intend to capture 3D data, ensuring that the markers on the calibration object
are visible to the cameras. Vicon Tracker begins to capture wand wave data.

6. In each Camera view pane, check the display of colored lines identifying wand
frames, ensuring that a good number of wand frames are spread across the
intended 3D capture volume.

® Tip

If no cameras are visible in the Camera view pane, make sure they are
selected on the System tab in the Resources pane.

If any optical camera does not capture wand data during a wand wave,
select the relevant camera on the System tab, look in the Settings
section of the Properties pane, and ensure you have set the Grayscale
Mode to Auto.

7. On the Calibrate tab, in the Camera Calibration Feedback section, check the
Wand Count values returned for each Vicon camera.

8. In the Calibrate Vicon Cameras section, click Stop. Vicon Tracker automatically
starts processing the camera calibration data.

(If you selected the Auto Stop option in the Parameters section, Tracker
automatically stops the calibration process when sufficient calibration
information has been acquired.)
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9. In the Camera Calibration Feedback section, monitor the progress bar until the
camera calibration process is complete and review the Wand Count and Image
Error data. As a general guideline, Tracker typically takes 15-60 seconds to
complete its calculations for a typical Vicon system setup. When the Vicon
camera calibration has successfully completed, it is automatically saved to an .
xcp file.

®@ Tip

Because calibration feedback values are based on factors such as the size of
the capture volume and the camera lens type, it is not possible to provide
general guidelines on typical or acceptable ranges. Therefore, to determine
the optimal values for your Vicon system, shortly after the system is installed
establish a baseline against which you can compare future daily calibration
values.

For more information, see:

I Camera calibration parameters on page 102
I Camera calibration feedback on page 105

I Setting the volume origin on page 106

I Changing the volume origin on page 108

I Managing camera calibrations on page 108

Camera calibration parameters

On the Calibrate tab, in the Calibrate Cameras section, you can change the following

settings:
Control Description
Wand The calibration object to be used during the camera calibration

process.

Calibration The level of camera calibration to be performed when the camera
Type calibration process is started:

I Full Calibration A full camera calibration process enables the Vicon
system to determine each camera's physical position and
orientation in the capture volume and to correct for any lens
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Control Description

distortions, and to set internal camera parameters. You must
perform a full camera calibration when the system is first installed
and set up or if your camera setup has changed significantly.

I Calibration Refinement A camera calibration refinement process
enables you to correct a simple problem with a camera calibration.
The Vicon system recalculates the previous calibration data based
on the current location of the cameras. You can refine an existing
calibration only if the camera positions have not changed
significantly.

For more information about calibration types, see Understanding
calibration types on page 104 below.

Cameras A list of cameras to be included in the camera calibration process.

To Calibrate Cameras not included in this list are not calibrated. If this field is
blank, all cameras are calibrated. The selection of cameras is applied
when you click the Stop button in the Calibrate Cameras section.

Refinement  With auto stop selected, the minimum coverage (in number of frames)
Frames required per camera in the final phase of the refine camera
calibration process.

Auto Stop Whether or not Tracker is to automatically stop the camera
calibration process when sufficient data has been collected.
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Understanding calibration types

Full Calibration consists of an initialization phase, followed by a multi-pass process to
optimize the camera positions.

Calibration Refinement uses exactly the same process as full calibration, but without
the initialization phase. It provides a reliable way to refine existing calibration data to
produce a calibration that is as good as a full calibration of the same system, but is
much faster.

Because Calibration Refinement operates on existing data, you must have loaded a full
calibration into Tracker before running the refinement calibration.

To save time while maintaining accuracy, you can perform both full and refinement
calibration on any selected camera(s), as well as on all cameras.

Note that the value specified for Refinement Frames affects the number of frames
used:

I By Auto Stop
I In the refinement phase of a Full Calibration
I When running a Calibration Refinement

The following table gives examples of using each type of calibration:

Scenario Type of calibration

A full calibration of all cameras has recently been Full Calibration on just the
performed, but since then, several cameras have moved cameras, with a short
been repositioned to another part of the volume. wand wave that concentrates

on the moved cameras,

A full calibration of all cameras has recently been Full Calibration on the bumped
performed, but during capture, one camera was camera, with a short wand
accidentally slightly bumped. wave that concentrates on the

bumped camera.

Since yesterday's full calibration, environmental Calibration Refinement of all
factors may have caused small changes in the cameras, with a normal length
camera positions and it is necessary to re- wand wave that includes all
calibrate them accurately and quickly. cameras.
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Camera calibration feedback

On the Calibrate tab in the Camera Calibration Feedback section, you can view the
camera calibration processing and status information. Camera Calibration Feedback
contains the following components:

Component  Description

Progress This bar displays a percentage indicating the progress of the overall

bar camera calibration process.

Camera This column contains the device ID for each Vicon camera being
calibrated.

Wand For each Vicon camera, this value identifies the number of frames it

Count has captured containing the calibration object. Initially, the entry for

the number of wand frames is displayed in red; the entry turns green
when Vicon Tracker has acquired enough wand data to calibrate that
camera (by default 1000 frames). Because Auto Stop is not selected
by default, the calibration process only stops when you click the Stop
button. If you have selected Auto Stop, the calibration process stops
when the Vicon camera with the lowest frame count reaches the
number of frames specified in the Refinement Frames field in the
Calibrate Cameras section.

World Error  Displays the calibration error in millimeters. World error is calculated
per camera from the Image Error in pixels and the distance of the
camera to the center of the volume. Cameras further away, with the
same image error, display a larger world error.

Image Error  This value (in RMS distance in camera pixels) indicates the accuracy
of the 3D reconstruction of the markers. This value represents the
difference between the 2D image of each marker on the camera
sensor and the 3D reconstructions of those markers projected back to
the camera's sensor. Acceptable values depend on factors such as
camera type. the size of the capture volume, and the camera lens

type.
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Setting the volume origin

Setting the volume origin tells the Vicon system where the center of your capture
volume is and what its orientation is (x, y, and z axes), so that subjects are displayed the
right way up in the Tracker workspace and so that you can change the way data is
visualized in the workspace. You set the global coordinate system immediately after
you calibrate your Vicon cameras.

Before starting the set volume origin process, remove from the capture volume
all markers and the sources of any unwanted reflections that have not been
accounted for by camera masks previously created. To set the volume origin,
you need a calibration object, which is supplied with your Vicon system.

To set the global coordinate system:

1. Display a 3D Perspective view.

2. On the Calibrate tab, in the Wand drop-down list, ensure that the calibration
object that you used when you calibrated the cameras is selected.

Tracker determines the unit of length for calculating the volume based
on the length of the calibration wand. If you specify a wand that is a
different length from the one you used during the Vicon camera
calibration, the volume will have the wrong unit of length, so Tracker
will be unable to locate the L-frame calibration object.

3. In the Set Volume Origin section, from the L-Frame drop-down list, select the
type of static calibration object you are using to set the volume origin.

4. In the capture volume, place the calibration object flat on the floor in the
position and orientation that you would like to be the origin of the global
coordinate system.

5. In the Set Volume Origin section, click Start.
The calibration object tracking process starts, Tracker identifies the calibration
object in the capture volume, displays a 3D representation of it in the 3D
Perspective view, and switches the Start button to its Set Origin setting.
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6. Click Set Origin to complete the calibration object tracking process.
Tracker sets the global origin and axes to correspond to the position and
orientation of the calibration object in the capture volume. In the 3D Perspective
view pane, the floor grid is displayed aligned with the capture volume floor and
the representations of the cameras are distributed in the position and
orientation in which the physical cameras are located around the capture
volume. When the global coordinate system has been successfully set, it is
automatically saved to an .xcp file.

7. Verify that the global coordinate system was set successfully by checking that
the system tracks the static calibration object.
If it does not, check the following:

I Was the correct dynamic calibration object selected from the Wand drop-down
list at the top of the tools pane?
If not, repeat this procedure from Step 2, ensuring that you select the correct
entry for the calibration wand you used for calibrating the Vicon cameras.

I Was the correct static calibration object selected from the L-Frame drop-down
list at the top of the Calibrate tab?
If not, repeat this procedure from Step 3, ensuring that you select the correct
entry for the L-frame you are using.

After you have set the global coordinate system, you can display the volume axis
marker in the lower-left corner of the 3D Perspective view pane.

You turn the display on or off in the Options dialog box by selecting or deselecting
Volume Axis under General View Options.

From Tracker 3.2 onward, you can also ensure that your coordinate system is accurately
aligned with the floor of the capture volume by automatically detecting the floor plane,
using markers in the volume to define it. For more information, see Improved floor plane
calibration in What's New in Tracker.
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Changing the volume origin
You can edit an existing calibration object to change the position of the volume origin.
To change the volume origin:

1. After you have completed the usual calibration and setting volume origin
procedures, load the calibration object that you used for calibration. To do this,
on the Objects tab, click the Load an Object button n and locate the relevant
calibration object. The default location is:
C:\Users\Public\Documents\Vicon\Tracker3.x\Objects

2. On the Objects tab, click the Pause button n

3. Move the calibration object in either of the following ways:

I On the System tab, click the object and in the Properties pane ensure Show
Advanced is selected, then edit the Global Position fields and Global Rotation
fields as necessary; or

I Drag the object in the view pane.

4, When you are happy with the position of the calibration object, right-click it and
click Save Object As. Enter a suitable name, and click Save.

5. Click the Calibrate tab, and in the Set Volume Origin section, select your
calibration object from the L-frame list.

6. In the Set Volume Origin section, click Start.
In the view pane, the cameras move to reflect the new position of the origin.

Managing camera calibrations

On the Calibrate tab, in the Manage Camera Calibration section, you can reset, load, or
save camera calibrations that define settings for the Vicon cameras in your Tracker
system.

During the Vicon camera calibration process, Vicon Tracker creates a calibration
parameters (.xcp) file. The changes in the .xcp file are automatically written to the
calibration file, which overwrites the current file. If you want to be able to load the
previous calibration in later, you must save it.

Changing a camera calibration can be useful in the following circumstances:
I To undo a poor calibration change.

I To compare calibration changes.
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To manage camera calibration files in Tracker:

I On the Calibrate tab, go to the Manage Camera Calibration section and click the
required button:

Button  Description

Reset Removes all nonexisting cameras, clears the calibrated position for
existing cameras, and reverts all calibration parameters to their default
settings. This enables you to recalibrate the system from a clean starting

point.

Load Displays the Choose a file dialog box, from which you can navigate to
and select the required .xcp file and click Open.

Save Saves the current calibration.
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About the Objects tab

RESOURCES

8!
@ ? MewTrial-100Hz *
®

FILTER. MODE PRESET MANAG

RESETS
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PROPERTIES

Object Tracking Mode:

|

SecondObject_1 CREATE

ADD

Create Object:

Add Marker Te Object:

Prepare and manage the objects whose motion data you want to track in Vicon Tracker
on the Objects tab. Objects are a rigid, asymmetrical arrangement of at least three
markers. Multiple objects can be defined to track many rigid bodies at the same time
and different smoothing filtration presets can be applied to each one.
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The Objects tab contains the following components:

Component  Description

Objects list Lets you enable an object for motion capture and data recording. If a
working .vsk file exists for the object, the object symbol is orange and
the object name is gray. If the name is red, the .vsk file is not suitable
for tracking (this may be due to symmetry in the arrangement of
markers, or similarity to another enabled object). To display a tool tip
identifying the problem, hover the mouse pointer over the object.

To display or hide the model markers defined in the .vsk file, expand (
+) or collapse (-) the Markers list.

Tips To manage specific objects, in the Objects list, right-click on the
relevant node and from the context menu select a command. The
Open Folder option, at the bottom of the context menu, provides a
quick way to locate a relevant file. The color-coded symbols displayed
for entries in the Markers list correspond to the colors defined for
each model marker in the .vsk file.

Filter Mode  Enables you to view and manage the type of smoothing applied to a

Preset selected object. Smoothing is achieved using a One Euro, low-pass
section smoothing filter. You can choose from one of the following supplied
filters:

I HMD: Used for head-mounted devices.
I InteractionDevice: Used for Vicon Apex.

I General: Used as a general purpose starting point
If none of the supplied filter types is suitable for your application,
you can also create and save your own custom filter presets, so that
you can quickly and accurately apply them to other objects (for
more information, see Creating an object on page 112).

Properties Enables you to view or edit object properties.
pane
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Component  Description

Object To view unlabeled reconstructions in the view pane (to enable you to

Tracking create new objects), ensure Track is not selected.

Mode Viewing unlabeled reconstructions requires additional processing, so

control for lowest output latency, when you have finished creating objects,
click the Track button to change to Track mode.

Create To create a new object, ensure Track mode is selected (see above),

Object select at least three trajectories in the view pane, enter a name in the

controls Create Object box, and click Create or press CTRL+E. For more
information, see Creating an object on page 112,

Add Marker  To add marker(s) to the selected trajectory of a selected object, click

to Object the Add button.

controls

If a calibrated object becomes distorted due to a marker having been

been lost and replaced in a slightly different position from its original
location, to update the marker position, select the affected marker
and click the Recalibrate button.

Creating an object

For motion capture and data streaming recording to take place, you must create
objects. Objects are a rigid, asymmetrical arrangement of at least three markers whose
motion data you want to track. Multiple objects can be defined to track many rigid
bodies at the same time. If necessary, you can apply different levels of filtration to each
object to obtain the required smoothing.

To create an object:

1. If you are streaming live, on the Objects tab in the Resources pane, click Pause

2. Ensure that in the Object Tracking Mode section at the bottom of the tab, Track
mode is not selected. This enables you to see unlabeled reconstructions in the
3D Perspective view pane.

3. In the view pane, zoom in (right-click + drag forward or backward) on the markers
to be defined as an object.
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. Select the markers you want to include by doing one of the following:

I To select markers individually, press and hold the CTRL key while you left-click
on each marker.

I To select a group of markers, press and hold the ALT key while you drag around
the markers to form a box around them.

. With the markers selected, enter a name in the Create Object box and then click
Create.

OBJECT TRACKING MODE:

CREATE OBJECT:

ADD MARKER TO OBJECT:

® Tip

In the Create Object text box, the name is automatically incremented by
1 each time you click Create, so that, to create another object with the
default name of ObjectName_n, you can just select the required markers
and click Create.

6. If required, apply object-specific smoothing (using One Euro filtration) to the

selected object. To do this:
a. Ensure that the newly created object is still selected.

b. Depending on whether you want to use an existing filtration type for this
object, do one of the following:

I If you want to use an existing filtration type, in the Filter Mode Preset
section, select it from the dropdown list and save the object as
described in step 9.

or

I If the required filtration type does not exist, in the Filter Mode Preset
section, click Manage Presets and in the Filter Presets dialog box, enter
a name in the Create New Preset box and then click Add.

c. In the Filter Presets section, ensure the new preset is selected, then in the
Smoothing section, change the Translation and Rotation properties as
required.
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d. With Translation Beta set to zero, change the value of Translation Min Cut-
Off to eliminate jitter during very slow movements.
Note that decreasing the value of Translation Min Cut-Off reduces jitter
but increases lag.

e. When you have finished adjusting the Translation Min Cut-Off value,
increase the value of Translation Beta by very small increments to
eliminate lag during faster movement.

Note that O = filtering on all translation motion; 1 = filtering on very slow
translation motion only.

f. Follow the same procedure for adjusting the Rotation Min Cut-Off and
Rotation Beta.
For detailed information on the One Euro filter and how to adjust these
settings, visit www.lifl.fr/~casiez/1euro/

g. When you have finished adjusting the properties, click Close.

7. On the Objects tab, make sure that in the Filter Mode Preset section, the
required filter is displayed for the selected object.

8. As required, make the following optional changes:

a. Left-click and drag the red, green, or blue axis lines emanating from the
center of the object (translation manipulator) to translate the origin of the
object to the desired position.

b. Left-click the translation manipulator to toggle to a rotation manipulator.
c. Drag the manipulator axes to orient the object to the desired pose.

d. Modify the object's properties in the Properties pane. For more
information, see Working with object properties on page 121.

9. Save the object by right-clicking it the Objects list and selecting Save Object
from the context menu.

TEM | Scaumrat I dranrl [ recoroms

a
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SAVE OBJECT

OPEN FOLDER

Tracker saves the contents of the object in a .vsk file in the Objects folder.
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Viewing unlabeled reconstructions requires additional processing, so for
lowest output latency, when you have finished creating objects, ensure Track
mode is selected. When Track mode is selected, the Track button is green.

Loading an existing object
You can open or load an existing .vsk file (object) in Tracker.

To load a .vsk file:

1. On the Objects tab tool bar, click the Load an Object button.

b

|l Load an Object iRt

2. In the Choose an Object File dialog box, navigate to an existing .vsk file, select it
and then click Open.

(D Caution

If the selected .vsk file has the same name as an object currently loaded in
Tracker, the contents of the selected .vsk file replace those in the currently
loaded object.
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Snapping the rotation of an object to a marker

You can change the orientation of an object in real time by snapping the rotation to a
marker.

To snap the rotation to a marker:

1. In the view pane, click a8 marker within an object.

2. Click any axis. Three circles associated with the axes are displayed.

3. Click on a circle and rotate it until you see a gray rectangular shape snap into
place.

To snap the position of an object to a marker:

1. In the view pane, click a marker within an object.

2. Click any axis and drag towards the marker until it snaps into place.
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Snapping a midpoint between markers

You can snap two markers together to measure the distance between the markers.
To snap a midpoint between markers:
1. In the view pane, select two markers by pressing CTRL while left-clicking each

marker.
A gray, projected marker is displayed at the midpoint between the two markers.

2. Left-click on the desired axis and move it towards the gray projected marker until
it snaps into the midpoint.
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Adding and detaching markers

You can easily add an existing marker to an object or detach a marker from an object.
To add a marker to an object:
1. In the view pane, to select the marker that you want to add to the object, click
the marker.
2. At the bottom of the Objects tab, click the Add button.

OBJECT TRACKING MODE:

CREATE OBJECT:

ADD MAREER TO DBIECT:

The mouse pointer now displays Select Object.

3. Click in the view pane.
The marker is now part of the object and is displayed in the Object list.

To detach a marker from an object:

1. In the view pane, right-click the marker to detach.

2. Select Detach Marker from the context menu.
The marker becomes disabled and is deleted from the object in the Object list.

Managing objects

After you have loaded an existing .vsk file or created a new object, you can save or
delete the object, or move its centroid as described in the following steps.

See also:
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I Positioning an object in the global coordinate system on page 120
I Work with grouped objects in What's New in Vicon Tracker

To save an object as .vsk file:

1. On the Objects tab in the Resources pane, right-click the object.

2. Select Save Object from the context menu.

Tracker saves the contents of the object in a .vsk file in the Objects folder.
To delete an object:
1. On the Objects tab, right-click the object and select Delete Object from the
context menu.

2. In the Warning confirmation message, click Yes to proceed.
Tracker deletes the object from the Objects tab, unloads the .vsk, removes the
labels from the trajectories associated with that object, and permanently deletes
it from the Objects folder.

To move the centroid of an object:

I Inthe view pane, click an axis and move along that axis until you reach the location
you want. Repeat for the other axis until the required location is reached.

Snapping an object to the global coordinate system

Tracker enables you to snap an object's axes to the global coordinate system, for
accurate positioning and aligning of objects.

To snap an object to the global coordinate system:

1. On the Objects pane, click the Pause button n

2. On the Window menu, click Options and in the dialog box, click Objects. Ensure
Snap Global is selected. If required, you can change the Snap Distance (mm).

3. Ensure nothing is selected and then in the view pane, drag or rotate the object
axes to enable them to snap to the grid.

®@ Tip

To change the distance between the lines of the grid to which objects can
snap, in the Options dialog box, select Floor Grid and adjust as required.
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Positioning an object in the global coordinate system

Tracker enables you to view and specify the values that determine the position of an
object within the global coordinate system.

To precisely position an object:

1. On the System tab, click the object and then in the Properties pane, click Show
Advanced.

2. In the view pane, drag or rotate the object's axes and observe the change in the
values in the Global Position fields (the location of the object within the global
coordinate system in millimeters) and Global Rotation fields (the orientation of
the object within the global coordinate system in degrees).

3. If required, change the Global Position and Global Rotation values.
The position of the object changes in the view pane.

@ Tip

To set the current position of the object to the global position of 0, O, O (that
is, the origin), click the arrow to the right of the Global Position fields and
select Set to Default.

Reorder Markers dialog box

The Reorder Markers dialog box enables you to change the order in which markers are
displayed on the Objects tab.

To change the order in which markers are displayed:
1. On the Object tab, if necessary, expand the node of the object whose markers
you want to change.
2. Right-click the Markers node and then click Reorder.

3. In the Reorder Markers dialog box, click to select the marker whose position you
want to change and choose from the following options:

I Move Up

I Move Down
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Working with object properties

In the Resources pane, when you click on an object on the Objects tab, you can
configure the following setting in the Properties pane.

Setting  Description

Name The name of the selected object. This name is used when the Vicon
Skeleton is saved in a .vsk file.

To change the name, do any of the following:

I In the Name box in the Properties pane, select the current name and
enter a new one; or

I Click the button next to the Name box to display the Name dialog box,
select the existing object name and enter a new one; or

I On the Objects tab, double-click the current name and enter a new one.

Changing marker color
You can change the color of object markers.

To change color properties:

1. Do one of the following:

I Select the marker in the Marker list.

Markers

Marker 1 [}
Marker 2
Marker 3
Marker 4

or

I Click on the marker in the view pane.
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2. In the Properties pane, click the currently displayed color in the Color box.

3. In the Select Color dialog box, assign a color in the Basic colors area, or define a
new color in the Custom colors area and then click OK.

Vicon Motion Systems Ltd. 02-Nov-2016 Page 122 of 173



Tracker

‘ICON User Guide

About the Recording tab

2 recorpme

TRIAL NAME:

FRAMES CAPTURED: 0

LOAD TRIAL... REPROCESS TRIAL

Filename: x\CapturedTrials\MewTrial.csv [

First Frame: First Frame

Last Frame: End Frame

Delimiter:
Local Mumeric Format:

Devices for Export:

Objects:
Unlabeled Trajectories:

CANCEL

Save and play back recordings of trial data, using the controls on the Recording tab.

(D Note

You will only see the Recording tab if you have the required license. For more
information, contact Vicon Support.
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The Recording tab contains the following components:

Component

Recording section

Location

Open
Folder

Trial Name

Auto
Increment
Trial
Number

Vicon Motion Systems Ltd.

Description

In the Recording section, specify your requirements for
recording live trials. When you have finished specifying
your requirements, click the Start button to begin
recording.

Select Private or Shared, depending on your requirements.

View the location of the saved files. The default file
location depends on whether files are saved as Shared or
Private:

I File type: Private
File location (English language version): C:
\Users\UserName\AppData\Roaming\Vicon\Tracker3.
x\CapturedTrials

I File type:Shared
File location (English language version): C:
\Users\Public\Documents\Vicon\Tracker3.
x\CapturedTrials

Note: For each trial recorded, at least three files are saved: .
x2d, .system, and .xcp files. In addition, whenever a new
calibration is performed, an additional .x2d file, of the
format LatestCalibration yyyymmddnnnnnn.x2d, containing
the latest calibration data, is saved in the same location as
the .x2d containing the recorded trial data. (This can be
useful for data analysis and troubleshooting.) If you are
using an analog device to capture data, an .x1d file is also
saved.

Enter a name for the new trial.

When selected, the trial number is automatically appended
to the file name.
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Component Description
Permit When selected, existing captured trial data in the same
Overwrite folder (see above) is overwritten when the new file is
of Existing  saved.
Files
Show Displays or hides additional controls, such as those for
/Hide remote triggering.
Parameters
Start/Stop When selected, a remote trigger can be used to control
on capturing start and stop times. The remote device must be
Remote connected to your Vicon system.
Trigger
Capture To capture data before the capture start is triggered either
Before manually (by clicking Start) or automatically (based on a
Start remote trigger), select this check box and enter the
(secs) required number of seconds.
Stop after To end the trial automatically after a specified number of
Duration seconds, select this check box and enter the required
(secs) number of seconds.
Start/Stop  To make a UDP broadcast to a third-party application that
over capture has started or stopped, select this check box and
Network from the adjacent drop-down list, select Send or Receive.

In the Address list, either select the IP address of the
network card that will be used to send or receive the start
/stop trigger message, or select All. In the adjacent field,
specify the UDP port which is to send or receive the
message.
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Component Description
Arm To set the system to a state where it is ready to accept a
button trigger for automatic capture based on a signal broadcast

over the network from a remote device, click this button. If
you want to enable the system to remain ready to receive
subsequent network signals after the capture is stopped,
click the Lock button to the right of the Arm button.

Playback In the Playback section, click the Load Trial button to select the trial you
section want to play back.

Export In the Export CSV section, select options to save trial data to a CSV file.
Csv For more information, see CSV Export in What's New in Vicon Tracker.
section

®@ Tip

Before attempting to load a trial, in the Recording section, ensure that the
relevant Location setting is selected (Shared or Private), depending the option
chosen for the trial you want to load.

Recording live trials

You specify your requirements for recording live trials on the Recording tab. If you use
the same setup each time, you can make subsequent recordings just by clicking the
Start button.

To record trial data:

1. Ensure your system is connected and calibrated and that Tracker is in Live mode.
2. In the Resources pane, click the Recording tab.

3. In the Location area, select whether your trial will be saved as Shared or Private
files.

4. In the Trial Name box, enter a name for the new trial. If you want a number to be
automatically appended to the file name, ensure Auto Increment Trial Number is
selected.
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5. If you want existing captured trial data in the same folder to be overwritten
when a new trial is saved, select the Permit Overwrite of Existing Files box.

6. Do one of the following:
I If you don't want to select any further parameters, go to step 7; or

I If your trial requires any further setup, for example, if you are using remote
triggering, click Show Parameters and supply the necessary information:

I Start/Stop on Remote Trigger To use a remote trigger to control capturing
start and stop times, select this check box. The remote device must be
connected to your Vicon system via a Giganet.

I Capture before Start (secs) To capture data before the capture start is
triggered either manually (by clicking Start) or automatically (based on a
remote trigger), select this check box and enter the required number of
seconds.

I Stop after Duration (secs) To end the trial automatically after a specified
number of seconds, select this check box and enter the required number of
seconds.

I Start/Stop over Network To make a UDP broadcast to a third-party
application that capture has started or stopped, select this check box and
from the adjacent drop-down list, select Send or Receive. In the Address list,
either select the IP address of the network card that will be used to send or
receive the start/stop trigger message, or select All. In the adjacent field,
specify the UDP port which is to send or receive the message.

I Arm button To set the system to a state where it is ready to accept a trigger
signal for automatic capture based on a signal broadcast over the network
from a remote device, click this button. If you want to enable the system to
remain ready to receive subsequent network signals after the capture is
stopped, click the Lock button to the right of the Arm button.

7. When you are ready to begin recording, click Start.
The Frames Captured number increases as frames are captured.
If you did not specify a number of seconds in the Stop after Duration box or if
you decide to end the capture before the specified time, click Stop when you
have finished capturing.
To abandon the trial without saving any data, click Cancel.

You can play back the captured trial immediately.
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Playing back recorded trials

You load and play recorded trials using the Recording tab and the view pane.

To play back recorded data:

1. On the Recording tab, in the Recording area ensure that the relevant Location
setting is selected (Shared or Private), depending on the option chosen for the
trial you want to load.

2. In the Playback arega, click Load Trial to access the location of the last saved trial.
If you want to load a different trial, browse to the appropriate location. Click Open

The recorded trial is loaded, a time bar appears beneath the view pane and
Tracker automatically enters Offline mode (if this was not already selected).

3. To play the recorded trial, click the Play button on the time bar. To stop or pause
the replay, click Stop or press the space bar on the keyboard. To view a particular
part of the trial, drag the slider along the time bar, or to move through the trial,
press the forward or back arrow keys.

To select from further options for examining the recorded data, click the More
option beneath the Play button on the time bar.

I Zoom to Trial — After zooming in to a selected range, resets the time bar scale
to include the whole trial

I Zoom to Region-of-Interest — After zooming out, resets the time bar scale to
zoom in to the selected range

I Replay Speed - Enables you to select from preset options (in multiples of real
time) or to specify your own custom speed

@ Tip

To select a region of interest, drag the beginning and end markers (small
green triangles) to the start and end of the required range on the time bar. To
return the markers to their original positions at the start and end of the trial,
double-click them.
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Monitoring system activity

You can monitor the activity of your Vicon system in the Communications pane. You
can view the updates in the Communications pane during any stage of the Tracker
motion capture workflow. For more information, see:

I About the Communications pane on page 130

I Working in the Communications pane on page 131
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About the Communications pane

Category Text
MIGHAL ( Attempt 1 to open telnet connection to device 16891 succeeded
MIGHAL ( ) Attempt 1 to open telnet connection to device 16969 succeeded
MIGHAL (l ) Attempt 1 to open telnet connection to device 16892 succeeded

MIGHAL ( ) Device connected successfully : 16891

MEKGHAL IEW) Broadcasting Preview Mode

MEGHAL [SY ighest priori nc master 1t

MIGHAL (SYMC) Highest priority ethernet sync master 4294967295 with priority

The Communications pane contains a single window, which displays a continual update
of Tracker system activity since start up as well as feedback on some motion capture
and processing operations. Vicon Support may ask you for log information if you
contact them to report a system problem.

The default position of the Communications pane is at the bottom of the Tracker
window. You can resize this pane, detach it from its current location, and move it to
another location within the Tracker window.

The Communications pane contains the following information:

Information Description

type

Time The timestamp for the operation being executed in the hh:mm:ss
format.

Category The general Tracker function being performed, for example

Calibration Manager.

Text The specific action and its success or failure.
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Working in the Communications pane

Text
MIGHAL (DEVICE) Attempt 1 to open telnet connection to device 16891 succeeded
MEBHAL ( CE) Attempt 1 to open telnet connection to device 16969 succeeded
MIGHAL (DEVICE) Attempt 1 to open telnet connection to device 16892 succeeded

MIGHAL ( CE) Device connected successfully : 16891

MEKGHAL ( IEW) Broadcasting Preview Mode

MIGHAL i ) Highest priority sync master 16800 with priority of 100

MIGHAL ( ) Highest priority ethernet sync master 4294967295 with priority of 0

You can monitor the activity of your Vicon system in the Communications pane. Its
default position is at the bottom of the Tracker window.

A new log is written each time you start Tracker. New entries recorded during the
current session are appended at the bottom of the log. You can copy all or part of the
information in the log and save it to an external file, such as a Rich Text Format (.rtf) or
plain text (.txt) file.

To monitor system activity:
1. In the Communications pane, view the entries for system activity and processing
operations.

2. Use the scroll bar to move down or back up the displayed entries.
To copy entries to external files:

1. Drag the cursor across the required entries.

2. Right-click and in the context menu click Copy. Tracker copies the text to the
clipboard.

3. Open a text editor, such as Microsoft Notepad, and paste the copied text.

To filter the log, right-click in the Communications pane.

You can choose to view or hide the following types of entries:
I Info - Information entries

I Warn - Warning entries

I Error — Error entries
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You can also change scrolling behavior and delete and restore entries:
I Auto-scroll — Automatically scrolls to the bottom of the list of entries
I Clear - Deletes all entries from the Communications pane

I Recover - Restores previously deleted entries.
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Viewing camera data

Vicon Tracker enables you to view camera data in a number of different ways,
depending on your selection in the Resources pane and the view pane.

For information on viewing camera data, see the following topics:
I About the view pane on page 134

I About the 3D Perspective view on page 139

I About the 3D Orthogonal view on page 141

I About the Camera view on page 144

I About the Graph view on page 151
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About the view pane

“3D PERSPECTIVE _*,

The view pane enables you to view the data of one or more cameras. In the view pane,
you view the objects selected in the Resources pane during any stage of the Tracker
workflow. Depending on the type of view pane selected, there are additional lists and
buttons available to you to manage the display options for that type of view pane.

By default, the view pane is above the Communication pane and to the right of the
Resources pane. You cannot detach or change the position of this pane, but you can
resize it. In addition, you can open a new floating workspace that can be displayed on a
second monitor, if required.

The view pane contains the following components:

Component Description

Configuration  Enable you manage the configurations that you create in the view

management pane. Saved configurations include the layout of view panes as well

controls as any cameras, hardware devices, and object components selected
in the Resources pane, on the System tab, the Calibration tab, the
Objects tab, and/or the Recording tab when the configuration was
created.

D!@ﬁ]

UNTITLED * ~
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Component Description
View pane The view pane list allows you to configure the way in which you
list view Tracker data. Select from the following types of view panes:

/3D PERSPECTIVE _*,
3D PERSPECTIVE
3D ORTHOGONAL
CAMERA
GRAPH

3D Perspective

Reconstructed motion capture data from all active Vicon cameras
in 3D.

/3D PERSPECTIVE _*,
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Component Description

3D Orthogonal

Motion capture data in 3D viewed from a specified point of sight or
direction of the capture volume.
/3D ORTHOGONAL el

Camera

Raw 2D motion capture data from an individual Vicon camera.

“/CAMERA  VIEW
#81 (MX T160)
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Component Description

Graph

Various values of one or more selected items, such as the x,y, and z
components of 8 marker trajectory, plotted against each other or
against time.

- Grapr 2

Count

Time (frames)

Split view By default, a single view pane is displayed in the workspace.

buttons Specify the number of view panes using the following buttons:

Horizontal Split the current view horizontally into two view

E panes.

Vertical m Split the current view vertically into two view panes.

Close Close the current view pane. You cannot close the
default view pane in the center of the Tracker

window.
View pane Enables you to play back recorded trials. Click More or right-click
time bar the time bar to access further options for examining recorded trial
data:
Zoom to After zooming in to a selected range, resets the
Trial time bar scale to include the whole trial
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Component Description
Zoom to After zooming out, resets the time bar scale to zoom
Region-of- in to the selected range
Interest
Replay Enables you to select from preset options or to
Speed specify your own custom speed

To select a region of interest, drag the beginning and end markers (small green
triangles) to the start and end of the required range.

To return the markers to their original positions at the start and end of the trial, double-
click them.
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About the 3D Perspective view

“3D PERSPECTIVE _*,

You view the reconstructed motion data from all active Vicon cameras in 3D.

The 3D Perspective view pane contains the following components.

Component  Description

3D You manage the display of 3D data in the active workspace by
Perspective  selecting the following button:

view pane r

tool bar Center camera on selection [ Positions the currently selected

data in the center of the view pane. This option does not
automatically zoom in on the selected data. When selecting an object
to "follow", the camera also rotates with the object.

3D You view and manipulate 3D data in the workspace. For example, the
Perspective  view can be oriented using the mouse and/or keyboard (see Mouse
view pane and keyboard shortcuts on page 41), such that you can focus on
workspace items of interest.
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Viewing data in 3D Perspective view

View reconstructed motion capture data from all active Vicon cameras.
When you have displayed a 3D Perspective view pane:

I You can highlight the representations of specific cameras by selecting one or more
cameras under the Vicon Cameras node on the System tab in the Resources pane.

I You can configure display options in the Options dialog box.

To view data in a 3D Perspective view pane:

1. Stream live camera data.

2. From the view pane tool bar, select 3D Perspective. The reconstructed 3D data
from all cameras is displayed in a single 3D Perspective view pane.

3. Select a marker and perform an action on it in either of the following ways:

I On the Objects tab, examine the reconstruction and labeling and edit any
errors or inconsistencies; or

I Right-click and select an option from the context menu.

®@ Tip

To select multiple objects, hold down the ALT key and drag around the objects
you want to select. To detach a marker, in the 3D Perspective view pane, right-
click the marker and in the context menu, click Detach Marker.
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About the 3D Orthogonal view

3D ORTHOGONAL £

View motion capture data in 3D perspective viewed from a specified point of sight, or
direction, of the capture volume.

The 3D Orthogonal view pane contains the following components:

Component
3D Orthogonal

view pane tool
bar

Vicon Motion Systems Ltd.

Description

Manage the display of data in the active workspace with the
following controls in the 3D Orthogonal view tool bar;

Orthogonal view list

Set the point of sight by selecting one of the following
orthogonal projections (also called orthographic projections):

Top (default)
Bottom

Left

Right

Front

Back
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Component Description

[ |

I Camera Centered on Selection [ button

Position the currently selected data in the center of the view
pane. This option does not automatically zoom in on the
selected data.

3D Orthogonal View and manipulate 3D data in the workspace.
view pane
workspace

Viewing data in 3D Orthogonal view

View motion capture data in 3D perspective viewed from a specified point of sight, or
direction, of the capture volume. You can view 3D data from an orthogonal perspective
live in real time or from a previously saved trial.

When you have displayed a 3D Orthogonal view pane, you can:
I Manage the visualization of graph data in the workspace.

I Highlight the representations of specific cameras in 3D Orthogonal view pane
workspace by selecting one or more cameras.

To view data in @ 3D Orthogonal view pane:

1. Stream live camera data.

2. From the view pane tool bar, select 3D Orthogonal. The reconstructed 3D data
from all cameras is displayed in a single 3D Orthogonal view pane, initially from
the Top view.
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3. From the View list in the 3D Orthogonal view pane tool bar, either leave the
default or select another orthogonal projection to set the view to a different
point of sight:

I Top (default)
I Bottom

I Left

I Right

I Front

I Back

4. In the 3D Orthogonal view pane, select a3 marker and perform an action on it in
either of the following ways:

I On the Objects tab, check the reconstruction and labeling and edit any errors
or inconsistencies; or

I Right-click and select a command from the displayed context menu.

@ Tip

You can select the Detach Marker command from the context menu displayed
when you right-click on a marker in the 3D Perspective view pane.
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About the Camera view

" CAMERA VIEW
#1 ] 60

View raw 2D motion capture data from an individual Vicon camera.

The Camera view pane contains the following components:

Component  Description

View Manage the way camera data is viewed in the active Camera view
pane by selecting the following options on the View drop-down list;
“CAMERA  VIEW

Il 30 OVERLAY
Il ROTATED

[l COMBINED
ZOOM TO FIT
ZOOM TO WINDOW

3D Overlay Overlay multiple Camera view panes on top of each
other, so all camera views are displayed in a single
view pane. Each camera is rendered in a unique
color.
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Component  Description

Rotated Rotate the camera view, so it is corrected to the
vertical axis defined in the system calibration
(which corresponds to the earth's vertical axis). It
also enables you to manually rotate the view by
dragging the view left or right. Information from the
camera calibration is required to present the
rotated view,

Combined Correctly model lens distortions and display a
corrected camera view with the 3D workspace
rendered underneath the camera view.

Zoom to Fit Zoom the selected Camera view pane to fit the full
workspace.

Zoom to Zoom to the displayed sensor window. For more

Window information, see New sensor windowing display in

What's New in Vicon Tracker.

Masks You can create a mask to hide any unwanted reflections and light
sources visible to a Vicon camera (such as stray reflections from other
objects or surfaces in the capture volume, opposing strobe units, and
direct light sources) with the following buttons in the Camera view
pane tool bar:

Paint @ mask Paint over any cells in the camera grid (displayed
onto the when the button is clicked) that contain unwanted
camera n reflections. When a cell is painted, its background

color changes from black to blue. The camera mask
consists of all blue cells obscuring unwanted

reflections.
Erase a mask Erase a previously painted cell from a mask. When
from the an individual cell is erased, its background color
camera changes from blue to black, and any reflection that

had previously been obscured is visible again.
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Component  Description

Clear the mask  Automatically remove a previously painted mask.

from the When the mask is cleared, the background color of

camera m any previously painted cells changes from blue to
black, and any reflections that had previously been
obscured are visible again.

Toggle Display When selected, grayscale blobs are displayed in the

display of grayscale blobs Camera view.

centroids b

/grayscale

blobs Display When selected, centroids are displayed in the
centroid Camera view.

circles $

Display When selected, the windowing of the sensor is
camera sensor  represented by a rectangle in the Camera view. For
window [=] more information, see New sensor windowing

display in What's New in Vicon Tracker.

Lock / Lock the current Camera view pane, so that it is effectively detached
Unlock from the selection set and is not affected by any subsequent
Selection selections in other open view panes. This is useful for displaying views
Set ﬂ from different cameras in multiple Camera view panes.

Camera You view and manipulate 2D data in the workspace. You can manage

workspace the visualization of camera data, for example, you can orbit, truck,
dolly, and zoom the displayed data.

For more information, see:

I Viewing optical data in Camera view on page 147
I Creating camera masks automatically on page 147
I Creating camera masks manually on page 148

I Save a configuration on page 150
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Viewing optical data in Camera view

View 2D optical data from Vicon cameras in the Camera view pane.

To view data in a3 Camera view pane:

1. Stream live camera data.
2. On the System tab in the Resources pane, select one or more cameras.

3. Expand the Vicon Cameras node and then click on the sub-node for one or more
specific Vicon cameras.

4. From the view pane tool bar, select Camera.

The 2D data from each camera selected on the System tab is displayed in a separate
Camera view.

®@ Tip

To help you to determine the most effect threshold setting for grayscale blobs,
you can set the background color of the Camera view to the value of the
Threshold control in the Centroid Fitting section of the Properties pane. To do
this, open the Options dialog box (F7), and in the General View Options, select
Threshold.

Creating camera masks automatically

You can automatically create camera masks using controls on the Calibrate tab, in the
Create Camera Masks section.

The automatic camera mask creation tool automatically creates masks to eliminate any
reflections in the capture volume that are visible to the cameras. You can subsequently
create masks manually to eliminate any remaining or additional reflections.

Before using the automatic mask creation tool, ensure that you remove from
the capture volume any unnecessary objects, such as calibration objects. For
best results, the capture volume should be entirely free from objects likely to
cause background interference.
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To automatically create camera masks:

1. Press F7 to open the Options dialog box and under General View Options, ensure
that Threshold Map is selected.
Any reflections are visible in the Camera view pane, typically as non-circular
areas of grayscale or edge data. Note that reflections can severely affect the
camera data rates, and you may find that the camera overloads. In this case, the
camera automatically sends edge data instead of full grayscale data.

2. On the Calibrate tab, in the Create Camera Masks section, click Start.
All Vicon cameras are selected and a separate Camera view pane is displayed for
each one. The Start button changes to display Stop. Tracker starts recording the
data visible to each of the Vicon cameras connected. Any camera masks that are
created are displayed as blue cells in the Camera view panes for the affected
cameras. If there is no data visible to a particular camera, Tracker does not
create any masks for it. About 30 seconds of recording is generally sufficient to
enable Tracker to collect the data visible to the cameras.

3. Click Stop.

Creating camera masks manually

You can manually create camera masks (a technique used to obscure selectively or
hold back parts of an image while allowing other parts to show) with the Masks buttons
in the Camera view pane tool bar, which eliminate any reflections in the capture
volume that are visible to the cameras. If you have a large number of reflections in your
capture volume, it is 3 good idea to initially create camera masks automatically.

Before manually creating any masks, ensure that you remove from the capture
volume any unnecessary objects, such as calibration objects. For best results,
the capture volume should be entirely free from objects likely to cause
background interference.

To manually create camera masks:

1. On the System tab in the Resources pane, select all Vicon cameras.

2. On the view pane tool bar, select Camera to display the 2D data being captured
by each selected Vicon camera in a separate Camera view pane.

3. From the View drop-down list in the Camera view pane tool bar, make sure that
the 3D Overlay and Combined options are cleared.
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4. Press F7 to open the Options dialog box and under General View Options, make
sure that Threshold Map is selected.

® Tip

The Threshold Map default color is blue, but you can change the color
in the Options dialog box.

5. Remove any unnecessary objects, such as calibration objects, from the capture
volume. For best results, the capture volume should be entirely free from objects
likely to cause unwanted reflections.

Any reflections are visible in the Camera view pane, typically as non-circular
areas of grayscale or edge data. Note that reflections can severely affect the
camera data rates, and you may find that the camera overloads. In this case, the
camera automatically sends edge data instead of full grayscale data.

6. From the Camera view pane tool bar, use the following buttons to hide any
unwanted reflections that are visible from the selected camera. (When you click
any of these buttons, a grid of small blue tiles is superimposed over the camera
image in each Camera view pane.)

Button Usage

Paint a Click an individual tile, click and drag across multiple consecutive

mask tiles, or hold down ALT and click while dragging the mouse across

onto an entire area of unwanted reflections visible in the camera grid.

the You can drag the mouse horizontally, vertically, or diagonally.

camera When a cell is painted, its background color changes from black to
m blue. The camera mask consists of all blue cells obscuring

unwanted reflections.

Erase a Click an individual tile, drag the mouse across multiple tiles, or hold

mask down ALT and click while dragging the mouse across an entire area
from of blue cells in the camera grid. You can drag the mouse

the horizontally, vertically, or diagonally.

caﬁfra When an individual cell is erased, its background color changes

from blue to black, and any reflection that had previously been
obscured is visible again.

Vicon Motion Systems Ltd. 02-Nov-2016 Page 149 of 173



Tracker

“ICON User Guide

Button Usage

Clear Click the button to automatically remove the entire mask from the
the camera.
mask . .
When the mask is cleared, the background color of any previously
from painted cells changes from blue to black, and any reflections that
the . . )
had previously been obscured are visible again.
camera

®@ Tip

To zoom in on the view pane, right-click and drag the mouse pointer
forward (to zoom in) or backward (to zoom out). To pan the image, click
both mouse buttons and drag. The camera masks are applied in real
time and are saved along with your camera calibration.

Save a configuration

To save a configuration:

In the configuration management section at the top of the System resources pane,

click the Save button H to save your system configuration settings to a .system file
in one of the following systems configurations folders:

I If you select Shared the file will be saved inC:
\Users\Public\Documents\Vicon\Tracker3.x\Configurations\Systems

I If you select Private it will be saved inC:
\Users\UserName\AppData\Roaming\Vicon\Tracker3.x\Configurations\Systems
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Time (frames)

Count

You view and manipulate various values of one or more selected items (such as the x, v,

and z components of a marker trajectory) against time.

The Graph view pane contains the following components.

Component

Graph view
pane tool
bar

Graph type

Vicon Motion Systems Ltd.

Description

You manage the display of graph data in the workspace with the
following controls and buttons on the Graph view pane tool bar at
the top of the view pane. The Graph view pane tool bar is designed
to lead you left to right through the normal flow of operations

required to plot a graph for the selected elements.

You select the type of graph to be displayed in the workspace from
under the categories in this drop-down list (graph types that are not

available for the current selection are dimmed):

DEVICES

COMPONENTS
TRAJECTORIES
COMPONENTS
DISTANCE FROM ORIGIN
DISTANCE BETWEEN
DISTANCE BETWEEN (XYZ)
ANGLE BETWEEN
TRAJECTORY COUNT
METRICS

LATENCY

OBJECTS

GLOBAL ANGLE

QUALITY

RELATIVE POSE

02-Nov-2016
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Component Description

Devices Components — Displays graphs for the components
of analog signals from force plates, or other analog
devices, such as EMG devices or accelerometers.

Trajectories | Components - The X, Y, and Z position of a
trajectory over time.

I Distance From Origin - The linear distance
between a trajectory and the origin.

I Distance Between - The distance between two
selected trajectories.

I Distance Between (xyz) — The absolute distance
(as a vector) between two selected trajectories.

I Angle Between - The angle between three
selected trajectories.

I Trajectory Count — The number of trajectories
being reconstructed.

Metrics I Latency - A measure of the time taken by Tracker
to perform some task. As data is received from the
hardware and is processed, Tracker takes
timestamps that are used to calculate the latency
estimate.There are two different kinds of latency
that are graphed if you are using Firmware 222.

I Data Delivered — The amount of time taken
between the sync packet being received and the
data for that frame being delivered from the
hardware. This is the integration period of the
camera - the time that it takes the camera to
process the sample and any Ethernet overheads.

I Data Processed - The amount of time between the
sync packet being received and the completion of
data processing.

Object Quality — The RMS error of a rigid body compared to
its model (VSK).
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Component Description

Segments I Global Angle - The global position and orientation
of a rigid body.

I Relative Pose - The difference in orientation
between two objects. The relative pose graph
shows the transformation from object A (the first
object selected) relative to object B (the second
object selected).

Differentiate  You specify for the displayed graph the current variable, its first
the Graph derivative (velocity or angular velocity), or its second derivative
H (acceleration or angular acceleration) by selecting the desired

options from this drop-down list:

I x (none)
I x' (velocity)

I x" (acceleration)
A graph of a trajectory will have X, Y, and Z axes, but when
differentiated to x' (velocity) will change to X', Y', and Z' axes.

Graph You specify the components of the selected graph type to be
Components  plotted in the active Graph view pane by selecting the required
- options from this drop-down list (only components that you have

selected for graph view are available):

I Components - Dependent on the type of graph you have chosen.
For example, the count for the Trajectory Count graph.

I Select None

I Select All
This option enables you to focus on a component of particular
interest, which occupies more of the workspace. When multiple
components are plotted, each is always shown on a separate axis,
and the components shown are applied to all channels visible in
the workspace. The number of vertically stacked graphs displayed
in the workspace depends on the type of graph selected and the
number of components selected from this component list.
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Component Description

Rotation If you select an object on the Object tab in the Resources pane, you

Order E can select Global Angle from the Graph view tool bar. This enables
the Rotation Order button. Clicking on the Rotation Order button
lists the angle convention choices of Helical (default), XYZ, XZY, etc.
This enables you to choose either a Helical or an Euler angle
convention. The Euler angle convention itself has multiple rotation
order conventions represented by XYZ, XZY, etc.

Show This button allows you to show a legend to the right of the graph
Legend trace for each component being plotted.

Scaling You manage the scale of the graph (to ensure that the desired
portions of the selected traces are visible) with these buttons:

Fit Zoom out the x-axis to show the complete range of
Horizontally  the trace for 100 frames. This is useful if you have
E zoomed in a long way and now want to quickly see

the entire graph again.

Lock Lock the horizontal graph axis so that the current
Horizontal zoom level is maintained.

Axis ﬂ

Fit Scale the y-axis so that all the data in selected traces
Vertically for the currently visible x-axis is visible. If there are
H multiple traces in the selected components, they are

all set to the same range required to show all the
data for all traces.

Lock Lock the vertical graph axis so that the current zoom
Vertical Axis level is maintained.

Fit Both Scale the x and y axes simultaneously to fit the
Horizontally  horizontal and vertical ranges of data.
& Vertically

ESY
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Lock/Unlock
Selection Set

Graph view
pane
workspace

Vicon Motion Systems Ltd.

Lock the current Graph view pane, so that it is effectively detached
from the selection set and is not affected by any subsequent
selections in other open view panes. This is useful for displaying
different elements in multiple Graph view panes.

You view and manipulate graph data in the workspace.

The workspace contains rulers and axes along the right and bottom
edges and graph traces for the item being plotted.

The y-axis vertical ruler is on the right side of the graph and the x-
axis horizontal ruler is below the graph. The y-axis represents the
selected component. The x-axis represents the time (in frames). It
starts on the right side, which is labeled O (current frame) and is
labeled from right to left with decreasing negative values to reflect
the number of frames away from the live frame.

Tips:

I To change the default number of samples to display when a new
real-time graph is opened, press F7 to open the Options dialog box,
click Graph on the left, and on the right side, change the Default X-
axis length value.

I When zooming into or out of graph data, the display of grid lines in
the workspace can be set to guide the eye toward the selected
area of focus. Major grid lines remain at their normal weight, while
any minor grid lines gradually fade. To obtain this behavior, press
F7 to open the Options dialog box, ensure Graph is selected and in
the Properties arega, select Show Minor Grid Lines.
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Viewing data in Graph view

You can display graphs of motion capture data in the Graph view pane.

The Graph view pane displays graphs for the types of data that can be produced in a
motion capture trial.

Graphs of trajectories data display three graphs of the X, Y, and Z components of
trajectories for two or more selected 3D markers, or a single graph of the trajectory
count for all 3D marker trajectories, against time. This is useful for analyzing 3D marker
trajectories and identifying gaps to be filled.

To view 3D trajectories in a graph:

1. Stream live camera data.

2. Select the markers to be graphed in either of the following ways. (The number of

markers you select depends on the type of graph you want to view, as described
in step 3 below.)

I On the Objects tab in the Resources pane, expand the required Object node,
expand the Markers node, and then select one or more markers; or

I In a 3D Perspective view pane, select one or more markers.

3. From the view pane tool bar, select Graph. A single Graph view pane is displayed
with the default Components graph type plotting the X, Y, and Z components of
each selected marker.

® Tip

When you have displayed a Graph view pane, you can select additional
markers to add to the Graph view pane. Each trajectory is displayed in 3
different color trace. To identify the color trace used for each trajectory,

click the Show Legend button (or hover the mouse pointer over it) in
the Graph view pane tool bar. If the trace for any additional markers is
not visible, use the Fit Horizontally, Fit Vertically, or Fit Both
Horizontally and Vertically buttons.

4. From the Graph Type list in the Graph view pane tool bar, select another option
under the Trajectories section to plot the selected marker trajectories in a
different type of graph:
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I Distance From Origin: Plots the distance from the capture volume origin to
each selected marker. This is useful for later plotting velocity or acceleration of
markers.

I Distance Between: Plots the absolute distance between two selected markers.
This is useful, for example, for seeing how the distance between two markers
that are assumed to have a rigid relationship, changes over time.

I Angle Between: Plots the angle between the two vectors formed by three
selected markers. This is useful for seeing how the group of markers move over
time.

I Trajectory Count: Plots the total number of trajectories over time visible to the
Vicon cameras (if streaming Live data in real time) or processed in trial (if
viewing previously captured data in a file).

5. If you want to save a particular graph view (for example, specific trajectories that
you have selected), save your configuration using the view pane configuration
management controls.

(o]0
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Using Vicon Tracker menus and options

For information on Vicon Tracker menus and on the controls in the Options dialog box,
see the following topics:

I About the menu bar on page 159

I Options dialog box on page 161
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About the menu bar

JTRACKER WINDOW HELP

The Vicon Tracker menu bar contains the following menus.

Menu Options Description

Tracker Undo Undoes the last action. This command is available only
after a relevant action has been performed.

Redo Reinstates the previously undone action. This
command is available only after an Undo command
has been performed.

Exit Closes the Tracker application window.

If you have not saved any changes, Tracker displays a
prompt to enable you to save changes before it closes.

Window New Floating Opens a separate floating view pane.
Workspace
Resources Displays or hides the Resources pane in which you

manage the components of your Vicon Tracker system
and the objects whose motion is to be captured. To
display the pane, select the check box next to the
option.

Communications Displays or hides the Communications pane in which
you view the state of your Vicon Tracker system. To
display the pane, select the check box next to the
option.

Sounds Displays or hides the Sounds dialog box. For more
information, see Instant auditory feedback in What's
New in Vicon Tracker.

Vicon Motion Systems Ltd. 02-Nov-2016 Page 159 of 173



Tracker

“ICON User Guide

Menu

Help

Vicon Motion Systems Ltd.

Options

Options

View Online
Help

View User Guide

Check for

Updates

About Vicon
Tracker

Vicon Product
Licensing

Description

Displays the Options dialog box in which you control
the way data is displayed in view panes. The Options
dialog box can also be displayed by pressing F7.

Opens the online Vicon Tracker Help system.

Opens a PDF of the Vicon Tracker User Guide that was
installed with Tracker.

Checks the currently installed version of Tracker and
enables you to update it if necessary.

Displays the Vicon Tracker startup screen, in which
you can view version information about the installed
release of Tracker.

Opens the Vicon Automated Unified Licensing Tool
(VAULT), which enables you to manage licenses. For
more information, see License Vicon Tracker on page
9.
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Options dialog box

PROPERTIES

<[ | <]l <J [<]<]<]<]<]

< [<]

To control the way data is visualized in the view panes, you use the controls in the
Options dialog box.

You access this dialog box from the Window menu or by pressing F7. You can save the
settings that you make in this dialog box, which enables you to customize sets of
options to use for different types of motion capture projects.

To configure settings in the Options dialog box:
1. Press F7 or from the Window menu, select Options. The Options dialog box is
displayed.

2. Inthe Options list on the left, select or clear the relevant check box(es),
depending on the functionality you require.

3. Toview or change the settings for an option, click on the option to select it. The
properties for that option are displayed in the Properties section.

® Tip

To see any available additional settings, click Show Advanced. To show
basic settings only, click Hide Advanced.
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4. In the Properties section, change the settings for the properties, as needed.

5. To save the changes you have made in the Options dialog box, in the
configuration management arega, click the save button:

[ oPTIONS

The Save As window is displayed.

6. Enter 3 name for the configuration and click OK,

@ Tip

To indicate that you have made changes to a configuration but the changes
have not yet been saved, an asterisk * is displayed after the configuration
name in the configuration management list.
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Extending your use of Vicon Tracker

In addition to using Tracker as part of a Vicon system as described in Tracker system
components on page 25, you can;

I Use Tracker's built-in VRPN server to extend your usage of Tracker (see Working with
VRPN on page 164).

I Use the Vicon Control app, to set up, calibrate, and capture with a Vicon Vantage, T-
Series or Bonita system (see Using the Vicon Control app with Tracker on page 166).
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Working with VRPN

The Virtual-Reality Peripheral Network (VRPN) is a library that provides an interface
between 3D immersive applications and tracking systems used for Virtools. Vicon
Tracker has a built-in VRPN server that will stream data natively into these applications
or will allow for the development of simple interfaces using VRPN.

For more information on working with VRPN, see:
I Using VRPN within Virtools on page 164

I Using dual VRPN outputs on page 165

Using VRPN within Virtools

Virtools, a commercial application, has support for VRPN and can be configured to
connect with Vicon Tracker as follows.

A full VRDevice.cfg file is included below.

(@ Note

Head@TrackerPC is the way Virtools connects to the VRPN server within
Tracker. The format is object_name@PC_Name. This configuration file will look
for an object called "Head" on the Tracker server called "TrackerPC."

vrpnTracker 0 Head@'r acker PC
neutral Position_0O 0.0 0.00.0

neutral Quaternion_0 0.0 0.0 0.0 1.0

axi sPermute_ 0 0 2 1

axisSign_0 111

trackerScale_0 1

Tracker Group_0 T0:0:6
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This VRDevice.cfg also contains other directives that:

I Map the Vicon coordinates properly to the Virtools coordinates:
axisPermute_0 0 21
axisSign_ 0111

I Add a tracker group with:
TrackerGroup_0 T0O:0:6

To complete the process, do the following:

I Add the VRPN settings to a VRPack.cfg file, which is in the same folder as the .cmo.
That way it can be tested with Virtools Dev.

I Forversions of Tracker before 1.2 in the composition, activate the Use Scale option
and change the value of trackerScale_0 in your VRDevice.cfg file to 0.001 (converts
Vicon mm to Virtools m).

For a full description of any of these configuration options, please refer to the Virtools
documentation.

For sample files that use VRPN to connect Virtools to a tracked object within Vicon
Tracker, please contact Vicon Support on page 173 or download from the Vicon
website.

Using dual VRPN outputs

If you are rendering the same object to different display types (for example, to both a
large screen and an immersive environment such as a head-mounted display), to obtain
smooth visualization on both display types, you are likely to need to apply different
amounts of filtration for each.

To enable you to do this, Tracker provides a second set of VRPN trackers, which are
output with the existing ones. For easy identification, the names of this second set of
VRPN trackers are suffixed with _2.

To enable second filtered VRPN trackers:
1. On the System tab, select Local Vicon System and in the Properties pane ensure
Show Advanced has been selected.

2. In the VRPN Stream section, select Add Filtered Tracker.
The second set of VRPN trackers includes customizable One Euro filtering. For
information on adjusting filtering parameters, see Creating an object on page
2.
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Using the Vicon Control app with Tracker

Control connects wirelessly to Vicon Tracker and streams camera data to your mobile
or tablet, enabling a single user to change camera settings, calibrate the system, and

start or stop capture from anywhere in the volume.

Before you can use your iOS device with Tracker, you must pair it with the PC that is
running Tracker (the Vicon host PC).

Connect Vicon Control

To connect an iOS device running the Vicon Control app to Tracker on a Vicon host PC:

1. Ensure that your iOS device is connected to a Wifi access point that is on the
same subnet as the Vicon host PC.

2. On the Vicon host PC, ensure that the required connection is used, that Tracker
is running, and the system is connected.

g

[ VICON TRACKER

TRACKER H

WINDOW

RESOURCES

. CONMECTED

3. On the device, open the Vicon Control app.
The connection to Tracker is displayed on the initial Control screen:
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4. Tap the Trackericon.

You are alerted that you must authorize the connection on the Vicon host PC
before you can continue.

In Tracker on the Vicon host PC, an authorization request is displayed:

Control on 'O iPad Air2 - #1 ' s reqquesting a prmection.

.. Bermernber this choice for fisfune connection atterngts,

5. To use the same connection in future, select Remember this choice for future
connection attempts. To permit Control to access Tracker, click Allow.

® Tip

If later you need to revoke authorizations for Vicon Control, on the
Window menu in Tracker, click Reset Control Authorization. This
revokes all stored authorizations.

On the device, a screen similar to the following is displayed:

6. To select a camera and display a camera view, tap at the bottom of the screen.

You can swipe the camera view right or left to change to the next or previous
camera and use stretch and pinch as normal to zoom in and out.
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To access the dial control, tap and hold in a selected camera view.

Use the dial to view and change settings, calibrate and capture.
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Regulatory information

For Vicon regulatory information details, see the following topics:
I ISO certification on page 170

I CE Declaration of Conformity on page 172
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ISO certification

Certificate schedule

Lloyd's Register
LRQA

CERTIFICATE SCHEDULE

Vicon Motion Systems Ltd t/a Vicon
14 Minns Business Park, West Way,
Oxford
United Kingdom

Lucaliuns Activities

7388 5 Revere Parkway, Configuration, sales and suppart of
Suite 801, motion capiure systems; including
Centennial CO 80112, development of related software.
Calarada,

UsA,

Approval Original Approval: 17 August 2006
Certificate No: LRQ 400314674
Current Certificate: 17 August 2015

Certificate Expiry: 16 August 2018

Page 1 of 1

1 Trinity Park. Bickenhill Lane, Birmingham, 037 765, Unied Kingsom
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ISO 9001_2008 Certificate of Approval

Vicon Motion Systems Ltd.

R Lloyd's Register
. LROA

CERTIFICATE OF APPROVAL

This is to certify that the Quality Management System of:

Vicon Motion Systems Ltd t/a Vicon
14 Minns Business Park, West Way,
Oxford
United Kingdom

has been approved by Lloyd's Register Quality Assurance
to the following Quality Managerment System Standards:

150 9001:2008

The Quality Management Systern is applicable to:
Design, manufacture and support of motion capture
systems. Development of software for motion
capture systems, measurement and analysis
of three-dimensional structures.
This certificate is valid anly in assodation with the certificate schedule bearing the same
number an which the locations applicsble to this approval are listed,
This certificate forms part of the approval identified by certificate number LRQ 4003146

Approval Original Appreval: 17 August 2006

Certificate No: LRQ 400314644
Current Certificate: 17 August 2015

Certificate Expiry: 16 August 2018

=

Issued by: Lloyd's Register Quality Assurance L mited

1 Trimty Park, Bigeeshil Lang, Brmingham, §37 785, Unted Kngdem

Evcann mh
ncorwbiry s
i

02-Nov-2016
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Declaration of Conformity

We, Vicon Motion Systems Limited
Unit 14 Minns Estate

Oxford OX2 0JB

United Kingdom

declare that the VICON Tracker Software Version 3.4 designed and supported by VICON
MOTION SYSTEMS LIMITED using an 1ISO9001:2008 Quality Management System
certified by Lloyd's Register Quality Assurance, for the design and support of motion
capture software. The Software is tested to the following minimum performance:

Environmental Measurement Criteria

I Independent of the lens fitted to each camera.

I Controlled lighting (no greater than 100 lux) and temperature (17-25°C)
Rigid Body Measurement Criteria

The mean position of a standard Vicon cluster origin from a sample size no less than
1000 samples shall not exceed Tmm away from its known position. The standard
deviation of this position will be no more than Tmm. The orientation of the standard
Vicon cluster origin from a sample size no less than 1000 samples shall not exceed 1
degree from its known orientation. The standard deviation of this position shall be no
more than 1 degree. Tests are performed using a minimum of four supported cameras(®
,at a range of 3 meters. The volume exercised shall be no greater than 1 meter cubed.
The 70mm sided cluster shall be fitted with a minimum of 4 markers.

T.M.L. Shannon PhD FIE (Aust), CPEng (Biomedical)
Director of Regulatory Compliance
28th October 2016

Not suitable for use in life- or safety-critical environments or applied as 3 medical
device.

Q) VVantage, Vero, T-series, F-series, MX3+, Bonita.
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Contact Vicon

If you need more information than that supplied in the documentation or
on the Vicon Support web pages, please contact Vicon:;

Denver, CO Los Angeles, CA
Vicon Denver Vicon LA

7388 S. Revere Parkway, Suite 901 3750 S. Robertson Boulevard, Suite 100
Centennial Culver City

CO 80112 Los Angeles

USA CA 90066
T:303.799.8686 USA

F:303.799.8690 T:303.799.8686

E: support@vicon.com F:310.388.3200
Oxford, UK E: support@vicon.com
Vicon Oxford Singapore

14 Minns Business Park Vicon Singapore
West Way T.+65 6400 3500
Oxford E: support@vicon.com
0OX2 0JB

UK

T:+44.1865.261800
F.+44.1865.240527
E: support@vicon.com

© Copyright 2016 Vicon Motion Systems. All rights reserved.

You .
&| f{v|Glin
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